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About these instructions
1 About these instructions
These instructions have been prepared with utmost care. They contain in-
formation and notes intended to ensure long-term and reliable operation.

Should you notice any discrepancies or if you have improvement requests, 
then we would be glad to receive your feedback through Customer 
Service ( p. 160).

Consider these instructions as part of the product and keep it easily 
accessible.

1.1 For whom are these instructions intended?
These instructions are intended for:

• Specialists:
This group has the appropriate technical training for performing 
maintenance or repairing malfunctions.

With regard to minimum qualification and other requirements to be met 
by personnel, please also follow the chapter Safety ( p. 10).

1.2 Representation conventions – symbols and characters
Various information in these instructions is represented or highlighted 
by the following characters in order to facilitate easy and quick 
understanding:

Proper setting
Specifies proper setting.

Disturbances
Specifies the disturbances that can occur from an incorrect adjustment.

Cover
Specifies which covers must be disassembled in order to access the com-
ponents to be set.
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About these instructions
Steps to be performed when operating the machine (sewing and 
equipping)

Steps to be performed for service, maintenance, and installation

Steps to be performed via the software control panel

The individual steps are numbered:
First step

Second step

The steps must always be followed in the specified order.

Lists are marked by bullet points.

Result of performing an operation
Change to the machine or on the display/control panel.

Important
Special attention must be paid to this point when performing a step.

Information
Additional information, e.g. on alternative operating options.

Order
Specifies the work to be performed before or after an adjustment.

References
 Reference to another section in these instructions.

Safety Important warnings for the user of the machine are specifically marked. 
Since safety is of particular importance, hazard symbols, levels of 
danger and their signal words are described separately in the chapter 
Safety ( p. 10).

Location
information

If no other clear location information is used in a figure, indications of 
right or left are always from the user's point of view.

1.

2.

…

•


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About these instructions
1.3 Other documents
The machine includes components from other manufacturers. Each man-
ufacturer has performed a hazard assessment for these purchased parts 
and confirmed their design compliance with applicable European and na-
tional regulations. The proper use of the built-in components is described 
in the corresponding manufacturer's instructions.

1.4 Liability
All information and notes in these instructions have been compiled in 
accordance with the latest technology and the applicable standards and 
regulations.

Dürkopp Adler cannot be held liable for any damage resulting from:

• Breakage and transport damages
• Failure to observe these instructions
• Improper use
• Unauthorized modifications to the machine
• Use of untrained personnel
• Use of unapproved parts

Transport
Dürkopp Adler cannot be held liable for breakage and transport damages. 
Inspect the delivery immediately upon receiving it. Report any damage 
to the last transport manager. This also applies if the packaging is not 
damaged. 

Leave machines, equipment and packaging material in the condition in 
which they were found when the damage was discovered. This will ensure 
any claims against the transport company.

Report all other complaints to Dürkopp Adler immediately after receiving 
the product.
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Safety
2 Safety
This chapter contains basic information for your safety. Read the instruc-
tions carefully before setting up or operating the machine. Failure to do so 
can result in serious injury and property damage.

2.1 Basic safety instructions
The machine may only be used as described in these instructions.

These instructions must be available at the machine's location at all times.

Work on live components and equipment is prohibited. Exceptions are 
defined in the DIN VDE 0105.

For the following work, switch off the machine at the main switch or 
disconnect the power plug:

• Replacing the needle or other sewing tools
• Leaving the workstation
• Performing maintenance work and repairs
• Threading

Missing or faulty parts could impair safety and damage the machine. 
Only use original parts from the manufacturer.

Transport Use a lifting carriage or stacker to transport the machine. Raise the machine 
max. 20 mm and secure it to prevent it from slipping off.

Setup The connecting cable must have a power plug approved in the relevant 
country. The power plug may only be assembled to the power cable by 
qualified specialists.

Obligations
of the operator

Follow the country-specific safety and accident prevention regulations and 
the legal regulations concerning industrial safety and the protection of 
the environment.

All the warnings and safety signs on the machine must always be in 
legible condition. Do not remove! 
Missing or damaged warnings and safety signs must be replaced 
immediately.

Requirements
to be met by

the personnel

Only qualified specialists may be used for:

• Setting up the machine/putting the machine into operation
• Performing maintenance work and repairs
• Performing work on electrical equipment

Only authorized persons may work on the machine and must first have 
understood these instructions.
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Safety
Operation Check the machine during operating for any externally visible damage. 
Stop working if you notice any changes to the machine. Report any chang-
es to your supervisor. Do not use a damaged machine any further.

Safety
equipment

Safety equipment should not be disassembled or deactivated. If it is 
essential to disassemble or deactivate safety equipment for a repair 
operation, it must be assembled and put back into operation immediately 
afterward.

2.2 Signal words and symbols used in warnings
Warnings in the text are distinguished by color bars. The color scheme 
is based on the severity of the danger. Signal words indicate the severity 
of the danger.

Signal words Signal words and the hazard they describe:

Symbols The following symbols indicate the type of danger to personnel:

Signal word Meaning

DANGER (with hazard symbol)
If ignored, fatal or serious injury will result

WARNING (with hazard symbol)
If ignored, fatal or serious injury can result

CAUTION (with hazard symbol)
If ignored, moderate or minor injury can result

CAUTION (with hazard symbol)
If ignored, environmental damage can result

NOTICE (without hazard symbol)
If ignored, property damage can result

Symbol Type of danger

General

Electric shock
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Safety
Examples Examples of the layout of warnings in the text:

 This is what a warning looks like for a hazard that will result in serious 
injury or even death if ignored.

 This is what a warning looks like for a hazard that could result in seri-
ous or even fatal injury if ignored.

 This is what a warning looks like for a hazard that could result in 
moderate or minor injury if the warning is ignored.

Puncture

Crushing

Environmental damage

Symbol Type of danger

DANGER
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

WARNING
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
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Safety
 This is what a warning looks like for a hazard that could result in 
environmental damage if ignored.

 This is what a warning looks like for a hazard that could result in 
property damage if ignored.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

NOTICE

Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
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Working basis
3 Working basis

3.1 Order of the adjustments
The settings for the machine are interdependent.

Always comply with the order of individual adjustment steps as specified.

It is absolutely essential that you follow all notices regarding prerequisites 
and subsequent adjustments that are marked with  in the margin.

3.2 Laying the cables

To lay the cables:

1. Lay any excess cables neatly in proper cable snakes.
2. Bind together the cable loops with cable ties.

Tie loops wherever possible to fixed parts.
Important
The cables must be secured firmly!

3. Cut off any overlapping cable ties.

NOTICE

Property damage may occur!
Machine damage from incorrect order.

It is essential to follow the working order specified in these 
instructions.

NOTICE

Machine damage and malfunctions can be caused by laying 
the cables incorrectly!
Excess cables can impair the functioning of moving machine parts. 
This impairs the sewing function and can result in damage.

Lay excess cables as described.
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Working basis
3.3 Removing and opening covers

In many types of setting work, you will have to remove the machine covers 
in order to access the components.

This chapter describes how to remove and then assemble the individual 
covers again. The text for each type of adjustment work then specifies only 
the cover that needs to be removed at that particular time.

3.3.1 Swiveling up the machine head

Fig. 1: Swiveling up the machine head

Important
The transport carriage (2) must be at the rear.

To swivel up the machine head:

1. Release the locking lever (4) under the tabletop.

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before removing or
re-assembling covers.

(1) - Head cover
(2) - Transport carriage

(3) - Latch
(4) - Locking lever

①

③

④

②
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Working basis
2. Lift the machine head in the head cover area (1) and swivel up carefully.
 The latch (2) latches into place.

The space under the stand is now accessible.

3.3.2 Swiveling down the machine head

Fig. 2: Swiveling down the machine head

To swivel down the machine head:

1. Hold the machine head in the head cover area (1).
2. Release the latch (2).
3. Swivel down the machine head carefully.
4. Latch the locking lever (3) under the tabletop.

NOTICE

Property damage may occur!
Risk of machine damage from falling machine head.

When swiveling down the machine head, hold the machine head in 
place until it has returned to its position.

(1) - Head cover
(2) - Latch

(3) - Locking lever

①

②

③

Service Instructions 911-211-10 - 00.0 - 11/2020 16



Working basis
3.3.3 Disassembling and assembling the motor cover

Fig. 3: Disassembling and assembling the motor cover

Disassembling the motor cover
To disassemble the motor cover:

1. Loosen both screws (1).
2. Disassemble the motor cover (2).

Assembling the motor cover
To assemble the motor cover:

1. Assemble the motor cover (2).
2. Tighten both screws (1).

3.3.4 Disassembling and assembling the arm cover

Fig. 4: Disassembling and assembling the arm cover

(1) - Screws (2) - Motor cover

①
②

(1) - Motor cover
(2) - Screws
(3) - Countersunk screw

(4) - Arm cover
(5) - Hand crank

②

④①

③

⑤
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Working basis
Disassembling the arm cover
To disassemble the arm cover:

1. Unscrew the motor cover (1).
2. Loosen screws (2) and countersunk screw (3).
3. Disassemble the arm cover (4).

Assembling the arm cover
To assemble the arm cover:

1. Assemble the arm cover (4).
2. Tighten the countersunk screw (3).
3. Tighten the screws (2).
4. Press down the hand crank (5) and check for ease of movement; 

adjust the arm cover position if necessary.
 The hand crank (5) must disengage.
5. Assemble the motor cover (1).

3.3.5 Disassembling and assembling the head cover

Fig. 5: Disassembling and assembling the head cover

Disassembling the head cover
To disassemble the head cover:

1. Loosen the screws (1).
2. Disassemble the head cover (2).

Assembling the head cover
To assemble the head cover:

1. Assemble the head cover (2).
2. Tighten the screws (1).

(1) - Screws (2) - Head cover

①

②
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Working basis
3.3.6 Disassembling and assembling the rear cover

Fig. 6: Disassembling and assembling the rear cover

Disassembling the rear cover
To disassemble the rear cover:

1. Loosen the screws (1).
2. Disassemble the rear cover (2) by moving it back.

Assembling the rear cover
To assemble the rear cover:

1. Assemble the rear cover (2).
2. Tighten the screws (1).

3.3.7 Disassembling and assembling the toothed belt cover

Fig. 7: Disassembling and assembling the toothed belt cover

(1) - Screws (2) - Rear cover

①

②

(1) - Screws (2) - Toothed belt cover

①

②
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Working basis
Disassembling the toothed belt cover
To disassemble the toothed belt cover:

1. Loosen the screws (1).
2. Disassemble toothed belt cover (2). 

Assembling the toothed belt cover
To assemble the toothed belt cover:

1. Assemble the toothed belt cover (2).
2. Tighten the screws (1).
Service Instructions 911-211-10 - 00.0 - 11/2020 20



Working basis
3.3.8 Opening and closing the hook cover

Fig. 8: Opening and closing the hook cover

Opening the hook cover
To open the hook cover:

1. Switch on the machine and reference it.
2. Remove the sewing material holder.
3. Press the Threading mode button.
 The hook cover (1) pivots to the side.

Closing the hook cover
To close the hook cover:

1. Release the Threading mode button.
 The machine is ready to sew again.

(1) - Hook cover

①
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Working basis
3.3.9 Disassembling and assembling the fabric sliding plate

Fig. 9: Disassembling and assembling the fabric sliding plate

Disassembling the fabric sliding plate
To disassemble the fabric sliding plate:

1. Reach through the hole (2) from below and lift the fabric sliding plate (1). 
2. Disassemble the fabric sliding plate (1).

Assembling the fabric sliding plate
To assemble the fabric sliding plate:

1. Assemble the fabric sliding plate (1).

(1) - Fabric sliding plate (2) - Hole

① ②
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Working basis
3.3.10 Disassembling and placing the thread burner cover (optional)

Fig. 10: Disassembling and assembling the thread burner cover

Disassembling the thread burner cover
To disassemble the thread burner cover:

1. Loosen the screws (2).
2. Disassemble the thread burner cover (1). 

Assembling the thread burner cover
To assemble the thread burner cover:

1. Assemble the thread burner cover (2).
2. Tighten the screws (1).

(1) - Thread burner cover (2) - Screws

①

②
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Working basis
3.4 Flats on shafts

Fig. 11: Flats on shafts

Some shafts have flat surfaces at the points where the components 
are clamped onto the shafts. This stabilizes the connection and makes 
adjusting easier.

Important
Ensure that the screws are completely flush with the surface.

3.5 Aligning the machine head

Fig. 12: Aligning the machine head (1)

(1) - Flat (2) - Shaft

①

②

(1) - Base plate
(2) - Tabletop

(3) - Flat material

①

②

③

X
X
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Working basis
Proper setting
The upper side of the base plate (1) is level with the cutout in the 
tabletop (2). Height X of the transport system is identical on the left 
and the right both at the rear and the front position of the carriage.
Check the height using the flat material (3).

To align the machine head:

1. Remove the sliding plate.
2. Check the position of the machine head using the flat material (3).
3. Swivel up the machine head ( p. 15).
4. Set the height.

Fig. 13: Aligning the machine head (2)

5. Check the position of the machine head again.
• Front
• Carriage at rear position
• Carriage at front position

X

X

Carriage at rear position

Carriage at front position
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Working basis
Fig. 14: Aligning the machine head (3)

6. Loosen the nuts (5).
7. Swivel down the machine head and lock it in place.
8. Use screws (4) to correct the height of the machine head at the front:

• higher = turn counterclockwise
• lower = turn clockwise

9. To adjust the locking mechanism, loosen the screws (6).
10. Move the block (7) up or down.

• To slacken the locking mechanism: Slide the block up
• To tighten the locking mechanism: Slide the block down

11. To test the setting, lock the machine head and check the play.
Proper setting
The locking mechanism is set correctly if the machine head can be locked 
in place with ease while not showing any play at the front bearing when 
moved up and down.

(4) - Screws
(5) - Nuts

(6) - Screws
(7) - Block

④

⑤

④

⑤

⑥

⑦
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Fig. 15: Aligning the machine head (4)

12. Loosen the screws on the left (not shown) and on the right (8).
13. Use the threaded pins on the left (not shown) and on the right (9) to 

adjust the height of the machine head at the rear:
• higher = turn clockwise
• lower = turn counterclockwise

14. Test the height of the base plate using flat material (3) and adjust as 
necessary.

15. Check heights X and adjust as necessary.
16. Check locking mechanism and adjust as necessary.

(8) - Screw on the right (9) - Threaded pin on the right

⑨

⑧
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Working basis
3.6 Locking the machine in place
For some adjustments, the machine must be locked in place. To do this, 
the locking peg from the accessories is inserted into a slot on the arm shaft 
crank, blocking the arm shaft.

Fig. 16: Locking the machine in place (1)

There are 2 securing positions:

• Position 1: Looping stroke position
• 5 mm end in the large slot
• Adjusting the looping stroke and needle bar height

• Position 2: Needle at top dead center
• 3 mm end in the small slot
• Checking the top dead center of the needle bar

Fig. 17: Locking the machine in place (2)

(1) - Locking peg
(2) - Large arresting groove

(3) - Small arresting groove
(4) - Arm shaft crank

(1) - Large arresting groove (2) - Locking peg

③

②

④

①

②①
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Working basis
Locking the machine in place
To lock the machine in place:

1. Insert the locking peg (2) with the appropriate end into the slot (1).

Removing the lock
To remove the lock:

1. Pull the locking peg (2) out of the slot (1).

3.7 Putting the machine into position
For some settings, the machine must be put into a certain position, using 
the hand crank on the arm cover.

Fig. 18: Putting the machine into position

To set the machine into position:

1. Press down and turn the hand crank (1) until the machine is in the 
setting position.

(1) - Hand crank

①
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Positioning the arm shaft crank
4 Positioning the arm shaft crank

Proper setting
The threaded pins (2) on the arm shaft crank (1) are seated completely on 
the flat.

Fig. 19: Positioning the arm shaft crank

To adjust the arm shaft crank:

1. Disassemble the arm cover ( p. 17).
2. Loosen the threaded pins (2).
3. Turn the arm shaft crank (1) such that the threaded pins (2) are seated 

completely on the flat of the arm shaft.
4. Push the arm shaft crank (1) to the right as far as it will go.
5. Tighten the threaded pins (2).

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before you check and set 
the position of the arm shaft crank.

(1) - Arm shaft crank (2) - Threaded pins

②

①

Service Instructions 911-211-10 - 00.0 - 11/2020 30



Positioning the toothed belt wheels
5 Positioning the toothed belt wheels

The two toothed belt wheels must be positioned relative to each other 
such that the toothed belt can run correctly.

Order
Always check the position of the other toothed belt wheel after making a 
change on either of the toothed belt wheels.

5.1 Adjusting the upper toothed belt wheel

Fig. 20: Adjusting the upper toothed belt wheel

Proper setting
The threaded pins for the upper toothed belt wheel are seated flush on 
the flat.

To adjust the upper toothed belt wheel:

1. Disassemble the arm cover ( p. 17).
2. Using the screwdriver, push the toothed belt (4) sufficiently far to 

the side so that the threaded pins (1) can be reached.
3. Loosen the threaded pins (1).

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before positioning the 
toothed belt wheels.

(1) - Threaded pins
(2) - Flat of arm shaft

(3) - Upper toothed belt wheel
(4) - Toothed belt

①

② ③

④
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Positioning the toothed belt wheels
4. Turn the upper toothed belt wheel (3) such that the threaded pins (1) 
are seated flush on the flat (2) of the arm shaft.

5. Tighten the threaded pins (1).
6. Use the screwdriver to push the toothed belt (4) back again.

5.2 Adjusting the lower toothed belt wheel

Fig. 21: Adjusting the lower toothed belt wheel

Proper setting
Both threaded pins for the lower toothed belt wheel are seated flush on 
the flat of the lower shaft.
The toothed belt runs correctly without running against the edge of the off-
set gear wheel or slipping off.

To adjust the lower toothed belt wheel:

1. Swivel up the machine head ( p. 15).
2. Remove the toothed belt cover ( p. 19).
3. Loosen the threaded pins (4).
4. Turn the lower toothed belt wheel (3) such that the threaded pins (4) 

are seated completely on the flat of the lower shaft.
5. Move the lower toothed belt wheel (3) sufficiently far to the side so 

that the toothed belt (1) makes contact with the edge (2) without 
being pushed away.

6. Tighten the threaded pins (4).

(1) - Toothed belt
(2) - Edge

(3) - Lower toothed belt wheel
(4) - Threaded pins

① ② ③ ④
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Aligning the needle bar linkage
6 Aligning the needle bar linkage

Fig. 22: Aligning the needle bar linkage

Proper setting
The needle enters the needle hole precisely in the center when the needle 
bar is at the bottom dead center.

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before aligning the needle 
bar linkage.

(1) - Threaded pins
(2) - Needle bar linkage

(3) - Needle hole

①

②

③
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Aligning the needle bar linkage
To align the needle bar linkage:

1. Disassemble the head cover ( p. 18).
2. Loosen the threaded pins (1).
3. Set the needle bar linkage (2) so that the needle enters the needle 

hole (3) precisely in the center.
4. Tighten the threaded pins (1).
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Position of the hook and needle
7 Position of the hook and needle

7.1 Adjusting the looping stroke position

Information
The looping stroke is the path length from the bottom dead center of 
the needle bar up to the height where the hook tip picks up the loop of 
thread.

Fig. 23: Adjusting the looping stroke position (1)

WARNING
Risk of injury from sharp parts!
Puncture possible.

Switch off the machine before adjusting the hook 
settings.

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before adjusting the hook 
settings.

(1) - Needle
(2) - Groove

(3) - Hook tip

① ③

②
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Position of the hook and needle
Order
First, check the following settings:

• Needle bar linkage ( p. 33)

Proper setting
The machine is locked in place at position 1 ( p. 28).

 The hook tip (3) is precisely at the center of the needle (1).
The looping stroke is precisely 2.4 mm.

Fig. 24: Adjusting the looping stroke position (2)

To adjust the looping stroke position:

1. Swivel up the machine head ( p. 15).
2. Lock the machine in place at position 1 ( p. 28).
3. Loosen the threaded pins (5) on the set collar (4).
4. Rotate the hook such that the hook tip (7) is precisely at the center 

of the groove (6).
5. Tighten the threaded pins (5).
6. Remove the lock ( p. 28).

Order
Then check the following settings:

• Adjusting the needle guard ( p. 40)
• Setting the timing of cutting by the thread trimmer ( p. 75)

(4) - Threaded pins
(5) - Set collar

(6) - Groove
(7) - Hook tip

⑦

④

⑤ ⑥
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Position of the hook and needle
7.2 Adjusting the needle bar height
Order
First, check the following settings:

• Adjusting the looping stroke position ( p. 35)

Proper setting
The machine is locked in place at position 1 ( p. 28).

 The hook tip is level with the lower third of the groove on the needle.

Fig. 25: Adjusting the needle bar height

To adjust the needle bar height:

1. Disassemble the head cover ( p. 18).
2. Open the hook cover ( p. 21).
3. Lock the machine in place at position 1 ( p. 28).
4. Loosen the screws (1).
5. Remove the throat plate (6).
6. Loosen the screw (3) of the needle bar (2).
7. Move the height of the needle bar (2) so that the hook tip (4) is in 

the middle of the lower third of the groove on the needle (5).
Important
When doing this, take care not to twist the needle. 
The groove (5) must face toward the hook.

(1) - Screws
(2) - Needle bar
(3) - Screw

(4) - Hook tip
(5) - Groove
(6) - Throat plate

④

⑤

⑥

①

②

③
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Position of the hook and needle
8. Tighten the screw (3) for the needle bar (2).
9. Place the throat plate (6).
10. Tighten the screws (1).
11. Remove the lock ( p. 28).

Order
Then check the following setting:

• Adjusting the needle guard ( p. 40)

7.3 Adjusting the hook side clearance

Order
First, check the following settings:

• Aligning the needle bar linkage ( p. 33)
• Adjusting the looping stroke position ( p. 35)

Proper setting
The machine is locked in place at position 1 ( p. 28).

 The distance between the hook tip and the groove of the needle is 
no greater than 0.1 mm.

NOTICE

Property damage may occur!
There is a risk of machine damage, needle breakage or damage 
to the thread if the distance between needle groove and hook tip is 
incorrect.

Check and, if necessary, readjust the distance to the hook tip after 
inserting a new needle with a different size.
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Position of the hook and needle
Fig. 26: Adjusting the hook side clearance

To adjust the hook side clearance:

1. Lock the machine in place at position 1 ( p. 28).
2. Swivel up the machine head ( p. 15).
3. Loosen the screws (2).
4. Loosen the threaded pins (1).
5. Move the hook support (3) sideways such that the distance between 

the hook tip (4) and the groove of the needle (5) is no greater than 
0.1 mm.
Ensure that the hook tip (4) does not touch the needle.

6. Tighten the screws (2).
7. Tighten the threaded pins (1).
8. Check the looping stroke position ( p. 35).
9. Remove the lock ( p. 28).

Order
Then check the following setting:

• Adjusting the needle guard ( p. 40)

(1) - Threaded pins
(2) - Screws
(3) - Hook support

(4) - Hook tip
(5) - Groove

③

②

④

⑤

②

①
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Position of the hook and needle
7.4 Adjusting the needle guard

The needle guard prevents contact between needle and hook tip.

Order
First, check the following settings:

• Adjusting the looping stroke position ( p. 35)
• Adjusting the hook side clearance ( p. 38)
• Adjusting the needle bar height ( p. 37)

Proper setting
Machine is locked in place at position 1 ( p. 28).

 The needle guard pushes the needle away just enough so that it is 
not touched by the hook tip.

Fig. 27: Adjusting the needle guard

To adjust the needle guard:

1. Press down and turn the hand crank and check how far the needle 
guard (1) pushes the needle (3) away.

NOTICE

Property damage may occur!
There is a risk of machine damage, needle breakage or damage 
to the thread if the distance between needle groove and hook tip 
is incorrect.

Check and, if necessary, readjust the distance to the hook tip after 
inserting a new needle with a different size.

(1) - Needle guard
(2) - Screw

(3) - Needle

③

①

②
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Position of the hook and needle
2. Turn the screw (2) such that the needle guard (1) just pushes the 
needle (3) far away enough so that it is not touched by the hook tip:
• To push away more forcefully: turn counterclockwise
• To push away less forcefully: turn clockwise

7.5 Adjusting the needle guide 
Proper setting
Machine is locked in place at position 1 ( p. 28).

 The needle guard pushes the needle just enough away so that it 
cannot be touched by the hook tip.

Fig. 28: Adjusting the needle guide

To adjust the needle guide:

1. Loosen the screws (1).
2. Remove the throat plate (2).
3. Lock the machine in place at position 1 ( p. 28).
4. Loosen the screw (4).
5. Move the needle guide (3) as close as possible against the needle.
6. Tighten the screw (4).
7. Check this distance using a piece of paper (5).

(1) - Screws
(2) - Throat plate
(3) - Needle guide

(4) - Screw
(5) - Paper

① ② ③ ④ ⑤
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Adjusting the bobbin case lifter
8 Adjusting the bobbin case lifter

Fig. 29: Adjusting the bobbin case lifter

The hook pulls the needle thread through between the nose of the bobbin 
case (3) and the middle section holder (4).
The bobbin case lifter (1) now pushes the bobbin case (2) away so that 
a gap appears for the thread.
If the hook tip is located below the bobbin case lifter, the bobbin case lifter 
must open so that the thread can also slide past in that position.
So that the thread can slip through without a problem, the width of the 
lifting gap and the timing of opening have to be adjusted.

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before adjusting the 
settings on the bobbin case lifter.

(1) - Bobbin case lifter
(2) - Bobbin case

(3) - Nose of the bobbin case
(4) - Middle section holder

③

④
①

②
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Adjusting the bobbin case lifter
8.1 Adjusting the lifting gap (standard hook bearing)
Order
Always check the width of the lifting gap after making changes to 
the needle thread size. The correct width of the lifting gap depends on 
the thickness of the needle thread.

Proper setting
The needle thread slides through unobstructed between the nose of 
the bobbin case and the middle section holder.

Fig. 30: Adjusting the lifting gap (standard hook bearing)

To adjust the lifting gap:

1. Swivel up the machine head ( p. 15).
2. Loosen the screw (2).
3. Push the cover (3) downwards.
4. Loosen the threaded pin (1).
5. Set the bobbin case lifter (4) such that the gap between the nose of 

the bobbin case and the middle section holder is just big enough for 
the needle thread to slip through without a problem.

6. Tighten the threaded pin (1).
7. Push the cover (3) upwards.
8. Tighten the screw (2).

(1) - Threaded pin
(2) - Screw

(3) - Cover
(4) - Bobbin case lifter

④

①

②

③
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Adjusting the bobbin case lifter
8.2 Adjusting the lifting gap (special hook bearing for safety 
belts)

Information
The lifting gap on the special hook bearing used for belts is markedly wider 
than the gap on the standard hook bearing.
If the hook thread under the seam is too loose when using short stitch 
lengths, you need to widen the passage between bobbin case lifter and 
bobbin case.

Fig. 31: Adjusting the lifting gap (special hook bearing for safety belts) (1)

Proper setting
The needle thread slides through the passage (1) unobstructed between 
bobbin case lifter and bobbin case.
At the moment when the bobbin case lifter is at the point (2), there must 
be still be a gap between the nose of the bobbin case and the middle 
section holder.

Fig. 32: Adjusting the lifting gap (2)

To adjust the lifting gap:

1. Swivel up the machine head ( p. 15).

(1) - Passage (2) - Point

②

①

(1) - Passage
(3) - Threaded pin
(4) - Screw

(5) - Cover
(6) - Bobbin case lifter

⑥

③

④

⑤ ①
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Adjusting the bobbin case lifter
2. Loosen the screw (4).
3. Push the cover (5) downwards.
4. Loosen the threaded pin (3).
5. Set the bobbin case lifter (6) such that the needle thread can pass 

through the passage (1) unobstructed between bobbin case lifter (6) 
and bobbin case.
At the moment when the bobbin case lifter is at the point (2), there 
must be still be a gap between the nose of the bobbin case and 
the middle section holder.

6. Tighten the threaded pin (3).
7. Push the cover (5) upwards.
8. Tighten the screw (4).

8.3 Adjusting the timing for opening 

Fig. 33: Adjusting the timing for opening

Proper setting
The bobbin case lifter starts to open exactly at the point when the hook tip 
is located below the bobbin case lifter after the loop is taken up.

To adjust the timing for opening:

1. Remove the plug (1).
2. Press and turn the hand crank until the tip of the needle is level with 

the throat plate. 
 The threaded pin (2) is accessible from the underside of the hook 

support.
3. Loosen the threaded pin (2) and use an allen key to turn it so that 

the allen key stands exactly vertical.
4. Tighten the threaded pin (2).
5. Insert the plug (1) into the opening.

(1) - Plug (2) - Threaded pin

① ②
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Sewing foot lift
9 Sewing foot lift

9.1 Adjusting the stroke position drive

Fig. 34: Adjusting the stroke position drive

Proper setting
The toothed rack must be 16.5 ± 0.5 mm distant from the top edge (1) 
of the stroke position housing. The threaded pins must be visible in 
the slotted hole and must be horizontal.

To adjust the stroke position drive:

1. Remove the motor cover.
2. Loosen the threaded pins (4).
3. Remove the gear wheel (3).
4. Move the toothed rack (2) to 16.5 mm below the upper stop.
5. Insert the gear wheel (3) so that the threaded pins (4) are horizontal.
6. Tighten the threaded pins (4).

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before adjusting the 
settings of the sewing foot lift.

(1) - Top edge of the stroke position
housing

(2) - Toothed rack

(3) - Gear wheel
(4) - Threaded pins

③ ④

①

②
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Sewing foot lift
9.2 Adjusting the light barrier

Fig. 35: Adjusting the light barrier

Proper setting
The light barrier with its mounting plate must be installed so that the 
toothed rack triggers it before reaching the upper stop.

 The distance between the bottom edge of the mounting plate and 
the stroke position housing should be approx. 3.5 mm.

To adjust the light barrier:

1. Disassemble the head cover ( p. 18).
2. Remove the motor cover.
3. Loosen the screw (3).
4. Adjust the mounting plate (2).
5. Tighten the screw (3).
6. Switch off and on the machine again.
7. Press Service.
8. Input the password (25483).
9. Press Multitest (Multi test) > Eingänge/Ausgänge testen 

(Test inputs/outputs).

(1) - Mounting plate
(2) - Light barrier

(3) - Screw
(4) - Lever

③

④
①

②
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Sewing foot lift
10. Push the lever (4) up and monitor the display.
 It will show either +103 or -103.
11. Check that the toothed rack still has about 0.5 mm clearance from 

the stop.
12. If necessary, set the light barrier again using the mounting plate.

9.3 Adjusting the left stop screw
Proper setting
The left stop screw (3) of the lifting gear must be set so that the lever (1) 
performs no stroke when it is lying against the stop block (4). The levers 
of the lifting gear (5) overlap.

To adjust the left stop screw:

1. Switch off and on the machine again.
2. Reference the machine.
3. Press Extras > Service > Multitest (Multi test) > Hublage 

einstellen (Set stroke position).
4. Press Hüpfer/Drücker (Jumping foot/presser foot) until 

the presser foot is selected.
5. Press and turn the hand crank and check that no stroke is performed.

Fig. 36: Adjusting the left stop screw

6. Loosen the nut (2).
7. Turn the stop screw (3).
8. Tighten the nut (4).

(1) - Lever
(2) - Nut
(3) - Stop screw

(4) - Stop block
(5) - Lifting gear lever

① ② ③ ④ ⑤
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Sewing foot lift
9.4 Adjusting the sewing foot stroke relative to the needle 
bar stroke

Fig. 37: Adjusting the sewing foot stroke relative to the needle bar stroke

Proper setting
The lifting gear (2) must be switched on so that it performs a stroke. 
The stop block (6) must then lie against the right-hand stop screw (5).
The eccentric (3) for the sewing foot stroke must be set so that

• when the needle bar is at bottom dead center - the presser foot is 
lowered

• after the looping stroke – the sewing foot stroke starts

To set the sewing foot stroke relative to the needle bar stroke:

1. Switch off and on the machine again.
2. Reference the machine.
3. Press Extras > Service > Multitest (Multi test) > Hublage 

einstellen (Set stroke position).
4. Press Hüpfer/Drücker (Jumping foot/presser foot) until 

the jumping foot is selected.
5. Switch on the sewing foot stroke in the control.
6. Set the machine head to the looping stroke position.
 The lever (1) must make a movement.

(1) - Lever
(2) - Lifting gear
(3) - Eccentric

(4) - Sewing foot stroke
(5) - Stop screw
(6) - Stop block

② ③

④

⑤

① ⑥
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Sewing foot lift
7. Loosen both threaded pins on the eccentric (3).
8. Rotate the eccentric (3) on the arm shaft.
9. Tighten both threaded pins on the eccentric (3).
10. Press and turn the hand crank and check that the lever (1) makes 

a movement.

9.5 Adjusting the sewing foot height
The sewing foot height can be set electronically from 1 mm to a maximum 
of 10 mm.

Proper setting
If a height of 1 mm is set in the control, the sewing foot must be 1 mm 
above the throat plate.

To adjust the height of the sewing foot:

1. Assemble the jumping foot.
2. Press Extras > Service > Multitest (Multi test) > Hublage 

einstellen (Set stroke position).
3. Press Hüpfer/Drücker (Jumping foot/presser foot) until 

the jumping foot is selected.
4. Press Nähfuß-Hub (Sewing foot stroke).
5. Enter a sewing foot height of 1.0 mm.
6. Move to position.
7. Turn the sewing foot to bottom dead center.
 The distance between the throat plate and sewing foot must be 1 mm.

Fig. 38: Adjusting the sewing foot height

8. Loosen the screw (3).
9. Turn the pivot shaft so that the distance between throat plate and 

sewing foot is 1 mm.

(1) - Nut
(2) - Screw

(3) - Screw

③

①

②
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Sewing foot lift
10. Tighten the screw (3).
11. Turn the sewing foot to top dead center.
 The distance between the throat plate and sewing foot must be 5 mm.
12. Loosen the nut (1).
13. Adjust the screw (2) so that the distance between the throat plate and 

sewing foot is 5 mm (corresponding to a 4 mm sewing foot stroke).

Information
The distance between min. and max. positions may have to be determined. 
If one of these settings is changed, the other setting must be checked again.

9.6 Adjusting the reference light barrier sewing axis

Fig. 39: Adjusting the reference light barrier sewing axis

Proper setting
The machine moves to the reference position with the needle bar at top 
dead center.

To adjust the reference light barrier:

1. Disassemble the arm cover ( p. 17).
2. Switch off and on the machine again.
3. Press Multitest (Multi test).
4. Input the password (25483).
5. Press Multitest (Multi test) > Eingänge/Ausgänge testen 

(Test inputs/outputs).
6. Lock the machine in place at position 2 ( p. 28).
7. Loosen the threaded pin (1).
8. Rotate the take-up lever disk (2) on the arm shaft accordingly.
 The switch S100 then switches.

(1) - Take-up lever disk (2) - Threaded pin

①

②
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Sewing foot lift
9. Tighten the threaded pin (1).
10. Remove the lock ( p. 28).
11. Switch off and on the machine again.
12. Check that the needle bar is at top dead center.
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Adjusting the needle thread tension
10 Adjusting the needle thread tension

10.1 Adjusting the needle thread regulator
The needle thread regulator determines the tension applied to guide 
the needle thread around the hook. The required tension depends on 
the thickness of the sewing material, the thread strength, and the stitch 
length.

Fig. 40: Adjusting the needle thread regulator

Proper setting
The loop of the needle thread slides at low tension over the thickest point 
of the hook, without forming loops or snagging.

To adjust the needle thread regulator:

1. Press down and turn the hand crank and monitor the progress of 
the needle thread around the hook.

2. Loosen the screw (1).
3. Move the needle thread regulator (2):

• more thread: slide to the left
• less thread: slide to the right

4. Tighten the screw (1).

(1) - Screw (2) - Needle thread regulator

+
1 2 3 4

①

②
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Adjusting the needle thread tension
10.2 Adjusting the thread tensioning spring 
The thread tensioning spring holds the needle thread under tension from 
the top dead center of the thread lever up to the point when the needle eye 
plunges into the sewing material.

Proper setting
Initial position: The thread tensioning spring does not contact the stop 
until the needle eye has plunged into the sewing material.

Important
The adjustment for the thread tensioning spring must be varied according 
to the sewing material and the required sewing result.

Fig. 41: Adjusting the thread tensioning spring

To adjust the thread tensioning spring:

1. Loosen the screw (4).
2. Adjusting the spring travel: Turn the stop collar (1):

• Longer spring travel: turn counterclockwise
• Shorter spring travel: turn clockwise

3. Adjusting the spring tension: Turn the tension disk (3):
• Greater spring tension: turn counterclockwise
• Lower spring tension: turn clockwise

Important
Do not twist the stop collar in doing so.

4. Tighten the screw (4).

(1) - Stop collar
(2) - Spring

(3) - Tension disk
(4) - Screw

①

②

④

③
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Adjusting the needle thread tension
10.3 Calibrating the mechanical thread tension plate

Fig. 42: Calibrating the mechanical thread tension plate

Important
BEFORE calibrating the mechanical thread tension plate:
open the menu Maschine (Machine) - Parameter (Parameters) - 
Konfiguration (Configuration) - Optionen (Options)
and select mechanische Fadenspannung (mechanical thread 
tension).

To calibrate the mechanical thread tension plate:

Adjusting the thread tension

1. Thread the needle thread 40/3 times without the thread tensioning 
spring (2).

2. Set the thread lever to the securing position and secure it ( p. 28).
3. Open the menu Extras - Service - Multitest (Multi test).
4. Enter the password 25483.
5. Next, use Eingänge/Ausgänge testen (Test inputs/outputs) 

to select output 15.
6. Confirm with OK.
7. Switch on output 15.
 Main tension is open.
8. Select output 14.
9. Confirm with OK.
10. Switch on output 14.
 Pretension is open.

(1) - Pretension
(2) - Thread tensioning spring

(3) - Main tension
(4) - Thread tension

③

①

②

④
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Adjusting the needle thread tension
Fig. 43: Calibrating the mechanical thread tension plate

11. Hook the spring balance (5) (up to 1kg) into the needle thread and pull 
the needle thread off evenly and parallel to the tabletop.

 The value should be below approx. 100g - for the 911-211-10 with 
thread burner, the value should be as low as possible and barely 
allow for the thread to be guided in the thread tension (4).

Fig. 44: Calibrating the mechanical thread tension plate

12. To adjust the thread tension, loosen the counternut (8) and turn the 
nut on the rear.
Increase the thread tension: turn clockwise
Reduce the thread tension: turn counterclockwise

13. To lock the tension, hold the nut in place and tighten the counternut (8) 
again.

Adjusting the pretension
14. Switch output 14 off again.
 The pretension is closed, while the main tension is still open.
15. Use the spring balance to check the thread tension again, which should 

be approx. 300g.

(5) - Spring balance

⑤

(6) - Adjusting wheel
(7) - Adjusting wheel

(8) - Counternut

⑧

⑦

⑥
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Adjusting the needle thread tension
16. To adjust the thread tension, turn the adjusting wheel (6):
Increase the thread tension: turn clockwise
Reduce the thread tension: turn counterclockwise

Adjusting the main tension
17. Switch output 14 back on.
 The pretension is open again.
18. Switch output 15 off.
 The main tension is closed.
19. Use the spring balance to check the thread tension again, which should 

be approx. 400-500g.
20. To adjust the thread tension, turn the adjusting wheel (7):

Increase the thread tension: turn clockwise
Reduce the thread tension: turn counterclockwise

Information
To increase the main tension, it is possible to activate the pretension as 
well. In the DACCAD, switch off output 14 at the desired TP or enter a 
tension value over 50%.

10.4 Adjusting the electronical thread tension plate

Fig. 45: Adjusting the thread tension plate

To adjust the thread tension plate:

1. Remove the needle thread from the thread tension.
2. Press Extras > Service > Multitest (Multi test).
3. Input the password (25483).

(1) - Tension disks
(2) - Washer

(3) - Nut
(4) - Screw

④

③
②

①
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Adjusting the needle thread tension
4. Press Fadenspannung (Thread tension) > Kalibrierung 
(Calibration 3).

5. Loosen screw (4) and nut (3).
6. Loosen the washer (2).
7. Turn the washer (2) clockwise as far as it will go.
 The tension disks lie flush on each other.
8. Use a (lead) pencil to mark 12 o'clock on the disk (2) and turn it 

approx. 15-30° clockwise.
9. Press ESC or OK.
10. Press Kalibrierung 1 (Calibration 1).
11. Turn back the nut (3) until reaching the screw head of the screw (4).
12. Screw in the screw (4) until the nut (3) is positioned approx. 2 mm in 

front of the washer (2).
13. Loosen the screw (4) until the tension disks (1) tighten.
14. Using an open-jaw wrench, lightly tighten the nut (3) and slowly loosen 

the screw (4) until the tension disks (1) tighten.
15. Press ESC.
16. Press Kalibrierung 3 (Calibration 3).
17. Hold the screw (4) still with a screwdriver, and tighten the nut (3). 

Once again, take care the disk (2) does not turn with the nut.
18. Press ESC and check that the tension disks (1) open easily.
19. Press Kalibrierung 1 (Calibration 1) and check the closure 

of the tension disks.

20. Repeat the procedure for the 2nd thread tension.

10.5 Calibrating the electronical thread tension plate

Fig. 46: Calibrating the thread tension plate

(1) - Thread lever (2) - Thread scale

①

②
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Adjusting the needle thread tension
To calibrate the thread tension plate:

1. Thread the needle thread 8/3 times and on to the thread lever (5).
2. With Kalibrierung 1 (Calibration 1) selected, measure 

the thread tension with a thread scale (6).
3. Input the measured value into the control and confirm it with OK.
4. Perform the measurement and input also for Kalibrierung 2 

(Calibration 2) and Kalibrierung 3 (Calibration 3).

Checking the calibration
1. Input the percentage value = 50 in the Fadenspannung (Thread 

tension) menu.
2. Press the Ein (On) button to switch on the tension.
3. Test the tension using a thread scale: Setpoint: 1000 cN.

If necessary, other percentage values can be input.
4. If variations ±10 % are found: Set the thread tensions once again 

and repeat the calibration.
5. If the variations persist: Clean any dirt from the thread tensions 

including the magnets.
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Thread trimmer
11 Thread trimmer

11.1 Adjusting the height of the thread-pulling knife
The height of the thread-pulling knife is factory-set so that the distance A 
between the upper edge of the knife carrier (4) and the hook bearing 
screw-on surface (3) is 10.7 + 0.05 mm. Fine adjustment is made by 
means of washers between the knife carrier (4) and the thread-pulling 
knife (2).

Important
When changing the knives, make sure that you do not lose the washers.

Fig. 47: Adjusting the height of the thread-pulling knife

Proper setting
The thread-pulling knife (2) pivots as close as possible above the hook 
and is at the same height as the counter blade (1).

To adjust the height of the thread-pulling knife:

1. Loosen the screw (5).
2. Disassemble the thread-pulling knife (2).

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before setting the thread 
trimmer.

(1) - Counter blade
(2) - Thread-pulling knife
(3) - Hook bearing

(4) - Knife carrier
(5) - Screw
A - Distance

③ ④

⑤

①

②

A
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Thread trimmer
3. Place as many washers between thread-pulling knife (2) and knife 
carrier (4) as necessary to ensure that the upper edges of counter 
blade (1) and thread-pulling knife (2) are at the same height.

4. Non-required washers on the top side between the thread-pulling 
knife (2) and screw (5) should be kept.

5. Screw down the thread-pulling knife (2) using screw (5).

11.2 Adjusting the cutoff curve

Fig. 48: Adjusting the cutoff curve (1)

Proper setting
The control cam (4) makes direct contact with the set collar (1).
The distance between the widest extent (6) of the control cam (4) and 
the roller (3) is 0.1 mm at most.
In resting position, the circle mark on the cutting edge of the thread-pulling 
knife is exactly next to the tip of the counter blade.

To adjust the cutoff curve:

1. Swivel up the machine head ( p. 15).
2. Open the hook cover ( p. 21).
3. Loosen the threaded pins (2) on the set collar (3).
4. Push the clamping ring (3) towards the hook bearing as far as it will go.
5. Tighten the threaded pins (2) on the set collar (3).

The clamping ring (3) and control cam (4) are both mutually used as 
a stop and should not be loosened at the same time.

6. Loosen the threaded pins (5).

(1) - Roller
(2) - Threaded pins
(3) - Set collar
(4) - Control cam
(5) - Threaded pins

(6) - Highest point
(7) - Clamping screws
(8) - Lever
(9) - Solenoid

③ ④
⑤

⑥

⑦

⑧

⑨

①

②
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Thread trimmer
7. Press the lever (8) against the solenoid (9).
8. Turn the control cam (4) until its highest point is next to the roller (1).
9. Move the control cam (4) such that the distance between its highest 

point (6) and the roller (1) is 0.1 mm at most.
10. Tighten the threaded pins (5).
11. Loosen the clamping screw (7) on the lever (8).

Fig. 49: Adjusting the cutoff curve (2)

12. Turn the thread-pulling knife (12) such that the circle mark is exactly 
next to the tip of the counter blade (11).

13. Tighten the clamping screw (7) on the actuating lever (8) such that 
the actuating lever (8) has no axial play.

14. Loosen the threaded pins (2) on the set collar (3).
15. Push the set collar (3) to the right as far as it will go and against 

the control cam (4).
Important
Check the looping stroke position ( p. 35).

16. Tighten the threaded pins (2) on the set collar (3).

(10) - Screw
(11) - Counter blade
(12) - Thread-pulling knife

(13) - Screw
(14) - Hook thread clamp
(15) - Screw

⑬

⑭⑮
⑩

⑪

⑫
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Thread trimmer
11.3 Adjusting the cutting pressure
The shape of the thread-pulling knife automatically creates the required 
cutting pressure as soon as the thread-pulling knife and counter blade 
make contact.

Fig. 50: Adjusting the cutting pressure

Proper setting
In resting position, the hook thread clamp makes contact with the thread-
pulling knife without any pressure being applied. Any 2 threads with the 
greatest strength used for sewing can be neatly cut simultaneously.

To adjust the cutting pressure:

1. Open the hook cover ( p. 21).
2. Press and turn the hand crank until the thread-pulling knife (3) can be 

swung out by hand.
3. Loosen the screw (1).
4. Position the thread-pulling knife (3) such that the arrow mark is exactly 

next to the tip of the counter blade (2).
5. Turn the hook thread clamp (5) such that it rests against the thread-

pulling knife (3). 
6. Turn the counter blade (2) such that it rests against the thread-pulling 

knife (3).
7. Tighten the screw (1).
Important
Check the position of the knife, as the counter blade can easily become 
warped when the screw is being tightened.

(1) - Screw
(2) - Counter blade
(3) - Thread-pulling knife

(4) - Screw
(5) - Hook thread clamp
(6) - Screw

④

⑤⑥
①

②

③
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Thread trimmer
11.4 Adjusting point in time for cutting

Fig. 51: Adjusting point in time for cutting

Proper setting
The threads are cut when the thread lever is at the top dead center.

To adjust the point in time for cutting:

1. Swivel up the machine head ( p. 15).
2. Open the hook cover ( p. 21).
3. Loosen the threaded pins (6).
4. Press and turn the hand crank until the thread-pulling knife (4) can be 

swung out by hand.
5. Pivot the thread-pulling knife (4) as far forward until the circle mark is 

exactly next to the tip of the counter blade (5).
6. Press and turn the hand crank until the thread lever is at the top dead 

center.
7. Push the control cam (3) to the left as far as it will go and against the 

set collar (2).
8. Turn the control cam (3) such that the roller (1) runs up at the contour 

of the control cam (3) and the widest extent of the control cam is at 
the highest point when the thread lever is at the top dead center.

9. Tighten the threaded pins (6).
10. Check the setting:

• Insert the thread into thread-pulling knife (4) and slowly press and 
turn the hand crank

• Determine the hand crank position at which the thread is cut
• Repeat setting steps 1 – 7 if necessary

(1) - Roller 
(2) - Set collar
(3) - Control cam

(4) - Thread-pulling knife
(5) - Counter blade
(6) - Threaded pins

④

⑤
⑥

①

②

③
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Thread burner (optional)
12 Thread burner (optional)

12.1 Adjusting the upper thread burner
Proper setting
The burner burns the thread off cleanly without damaging the sewing 
material.
The burner pivots quickly without coming into contact with the stop.

To adjust the upper thread burner:

1. Remove the thread burner cover ( p. 23).
2. Press Extras > Service > Multitest (Multi test).
3. Press Fadenbrenner (Thread burner).
4. Press Klammer schließen (Close clamp).
5. Use Brenner oben runter (Upper burner down) to check 

the movement sequence.

Fig. 52: Adjusting the upper thread burner

 Both threads (1) are burnt off and sucked in.
The thread burner (2) is positioned slightly to the left opposite 
the needle hole.

(1) - Threads (2) - Thread burner

① ②
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Thread burner (optional)
12.1.1 Adjusting the thread burner height

Fig. 53: Adjusting the thread burner height (1)

To adjust the thread burner height:

1. Loosen the nuts (4).
2. Position the bracket (3) at the desired bottom limit.
3. Tighten the nuts (4).
4. Use the threaded pin (2) to adjust the upper limit such that there is as 

little play as possible when the thread burner is at its topmost position.
5. Lock with the nut (1)
6. Insert the sewing material.
7. Check the movement sequence.

(1) - Nut
(2) - Threaded pin

(3) - Bracket
(4) - Nuts

④

②① ③
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Thread burner (optional)
Fig. 54: Adjusting the thread burner height (2), adjusting the material thickness scanner

8. Adjust the material thickness scanner in relieved condition if necessary:
• Loosen the screws (5) and adjust the height of the material thick-

ness scanner (6)
• Tighten the screws (5)

(5) - Screws (6) - Material thickness scanner

⑤

⑥
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Thread burner (optional)
12.1.2 Adjusting the needle thread advancing device

Fig. 55: Adjusting the needle thread advancing device

Proper setting
The needle thread advancing device pivots quickly while advancing and 
slightly pulling back the thread at the same time. 
The needle thread advancing device positions the thread for the suction 
device.
When being burnt off, the thread is not under tension.

To adjust the needle thread advancing device:

1. Loosen the screw (1). 
2. Move the needle thread advancing device (3) such that it passes over 

the clamp and under the sewing foot when completing its forward 
motion.

3. Tighten the screw (1).
4. Use the stop screw (2) to limit the swivel angle.

(1) - Screw
(2) - Stop screw

(3) - Needle thread advancing device

③①

②
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Thread burner (optional)
12.1.3 Adjusting the position of the thread burner tip

Fig. 56: Adjusting the position of the thread burner tip

To adjust the position of the thread burner tip:

1. Loosen the screws (3).
2. Adjust the length of the thread burner tip (1).
3. Tighten the screws (3).
4. Use the screws (2) to make a height adjustment if necessary.

(1) - Thread burner tip
(2) - Screws

(3) - Screws

②

③①
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Thread burner (optional)
12.1.4 Adjusting the throttle valves

Fig. 57: Adjusting the throttle valves

To adjust the throttle valves:

1. Adjust throttle valves (1) and (2).

12.1.5 Adjusting the thread suction device

Fig. 58: Adjusting the thread suction device

Proper setting
The thread suction device reliably sucks in the thread. 
Even though positioned closely to the swung-out needle thread advancing 
device, the thread suction device does not interfere with the swivel motion 
performed by the needle thread advancing device.

(1) - Throttle valve - upward movement (2) - Throttle valve - downward movement

①

②

(1) - Angle bracket with screws

①
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Thread burner (optional)
To adjust the thread suction device:

1. Depending on the clamping system used, set the position of the thread 
suction device using the screws on the angle bracket (1).

12.2 Adjusting the lower thread burner

Fig. 59: Adjusting the lower thread burner

Proper setting
The burner burns the thread off cleanly without damaging the sewing 
material.
The movement is quick.

To adjust the lower thread burner:

1. Swivel up the machine head ( p. 15).
2. Loosen the screws (2).
3. Press Extras > Service > Multitest (Multi test).
4. Press Fadenbrenner (Thread burner).
5. Press Klammer schließen (Close clamp).
6. Use Brenner unten rauf (Lower burner up) to check the 

movement sequence.
7. Adjust the height of the thread burner holder until the thread burner tip 

is positioned closely under the throat plate.
8. Tighten the screws (2).
9. Loosen the screws (3).
10. Move the thread burner holder sideways until the thread burner tip is 

positioned in the center, as seen from the top through the needle hole.
11. Tighten the screws (3).
12. Adjust throttle valves (4) and (5).

(1) - Thread burner tip
(2) - Screws
(3) - Screws

(4) - Throttle valve - upward movement
(5) - Throttle valve - downward movement

③ ④

⑤

①

②
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Thread burner (optional)
13. Check the movement sequence and readjust it if necessary.

12.2.1 Adjusting the thread advancing device

Fig. 60: Adjusting the thread advancing device

Proper setting
When the thread advancing device (2) is at rest, the distance between 
the highest point of the control cam (6) and the roller (5) is 0.1 mm.
The control cam (6) makes contact with the set collar (4).
The carrier (1) has no axial play, but can still run smoothly.

To adjust the thread advancing device:

1. Loosen the threaded pins on the clamping ring (4).
2. Push the clamping ring (4) towards the hook bearing as far as it will go. 
3. Tighten the threaded pins on the clamping ring (4).
4. Loosen the threaded pins on the control cam (6).
5. Turn the lever (7) so that the threaded pin (9) on the body casting (3) 

strikes the hook support.
6. Set the distance between the roller (5) and the highest point of 

the control cam (6) to 0.1 mm.
7. Tighten both threaded pins on the control cam (6).
8. Loosen the clamping screw (8) on the lever (7).
9. Turn the thread advancing device (2) until the bobbin can be removed.
10. Tighten the clamping screw (8). Take care to ensure that there is no 

axial play.
11. Loosen the threaded pins on the clamping ring (4) and push the clamp-

ing ring as far as it will go and against the control cam (6).

(1) - Carrier
(2) - Thread advancing device
(3) - Body casting
(4) - Set collar
(5) - Roller

(6) - Control cam
(7) - Lever
(8) - Clamping screw
(9) - Threaded pin

⑨

①

②

⑧③ ④ ⑤ ⑥ ⑦
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Thread burner (optional)
12. Tighten the threaded pins on the clamping ring (4).
13. Check the looping stroke ( p. 35).

12.2.2 Adjusting the locking latch

Fig. 61: Adjusting the locking latch

Proper setting
The roller (5) is at the highest point of the control cam (6).
Once pressure is exerted against the magnet armature (1), the locking 
latch (2) can be swung out without clamping.
When the latch is engaged, the distance between the locking latch (2) 
and locking pin (7) is no greater than 0.1 mm.

To adjust the locking latch:

1. Loosen the nut (4).
2. Turn the threaded pin (3) and set the distance.
3. Tighten the nut (4).

(1) - Magnet armature
(2) - Locking latch
(3) - Threaded pin
(4) - Nut

(5) - Roller
(6) - Control cam
(7) - Locking pin

①

②

③

④

⑤

⑥

⑦
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Thread burner (optional)
12.2.3 Adjusting the hook thread clamp

Fig. 62: Adjusting the hook thread clamp

Proper setting
The thread is held in place, but not clamped.

To adjust the hook thread clamp:

1. Swivel up the machine head ( p. 15).
2. Open the hook cover ( p. 21).
3. Press against the magnet armature (1) while pressing and turning 

the hand crank until the thread advancing device (2) swings out.
4. Insert the end of the hook thread into the thread advancing device.
5. Press and turn the hand crank until the cutter swings back.
6. Check if the thread is held in place without being clamped.

(1) - Magnet armature
(2) - Thread advancing device

(3) - Hook thread clamp

① ② ③
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Thread burner (optional)
12.2.4 Adjusting the control cam of the thread advancing device

Fig. 63: Adjusting the control cam of the thread advancing device

Proper setting
The thread advancing device is in its idle position when at the position 
thread lever at top dead center. When the machine is at the position thread 
lever at top dead center, the control cam (1) is at its highest position.
The thread advancing device captures the hook thread, but not the needle 
thread. If there are any short pieces of thread in the area of the hook that 
have been burnt off on both sides, the thread advancing device will cap-
ture the needle thread as well. In this case, the control cam will have to be 
corrected to allow the thread advancing device to swing out with a delay.

To adjust the control cam of the thread advancing device:

1. Press the hand crank and turn it to the position "thread lever at top 
dead center".

2. Loosen the threaded pins (2).
3. Rotate the control cam (1).
4. Tighten the threaded pins (2).

(1) - Control cam (2) - Threaded pins

①

②
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Thread burner (optional)
12.3 Replacing the thread burner tips

Fig. 64: Replacing the thread burner tips

To replace the thread burner tips:

1. Remove the thread burner cover ( p. 23).
2. Swivel up the machine head ( p. 15).
3. Loosen the screws (1).
4. Replace the thread burner tip (2).
5. Tighten the screws (1).
6. Press Extras > Service > Multitest (Multi test) > 

Fadenbrenner (Thread burner).
7. Use Brenner an (Burner on) to verify that the thread burner tip 

is glowing (turns off automatically after 10 s). 

(1) - Screws (2) - Thread burner tip

①

②
①
②
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Changing the presser bar
13 Changing the presser bar

13.1 Disassembling the presser bar

Fig. 65: Disassembling the presser bar (1)

To disassemble the presser bar:

1. Remove the motor cover ( p. 17).
2. Loosen the threaded pins (2) and pull the bearing with the gear 

wheel (1) out towards the front.
3. Disassemble the drive (3).
4. Loosen the screws (4) and remove the drive shaft.
5. Loosen the screw (5).

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before you disassemble or 
assemble the cloth pressure bar.

(1) - Bearing with gear wheel
(2) - Threaded pins
(3) - Drive

(4) - Screws
(5) - Screw

⑤

①

②

③

④
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Changing the presser bar
Fig. 66: Disassembling the presser bar (2)

6. Position the clip (7) so that the screw (7) is accessible.
7. Loosen the screw (10) and disassemble the clip (7).
8. Pull the sleeve (10) out.
9. Pull the clamp (6) right up to the top and pull the presser bar (8) out 

upwards.

(6) - Block
(7) - Clip
(8) - Presser bar

(9) - Sleeve
(10) - Screw

⑥

⑦

⑧

⑨

⑩
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Changing the presser bar
13.1.1 Assembling the presser bar

Fig. 67: Assembling the presser bar (1)

To assemble the presser bar:

1. Insert the presser bar (3).
2. Push the block (1) downwards.
3. Insert the sleeve (4).
4. Place the clip (2) and tighten the screw (5).

(1) - Block
(2) - Clip
(3) - Presser bar

(4) - Sleeve
(5) - Screw

①

②

③

④

⑤
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Changing the presser bar
Fig. 68: Assembling the presser bar (2)

5. Tighten the screw (10).
6. Place the drive shaft and tighten the screws (9).
7. Assemble the drive (8).
8. Slip on the bearing with gear wheel (6).
9. Tighten the threaded pins (7).
Order
After that, set the sewing foot height ( p. 50).

(6) - Bearing with gear wheel
(7) - Threaded pins
(8) - Drive

(9) - Screws
(10) - Screw

⑩

⑥

⑦

⑧

⑨
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Checking the machine zero point
14 Checking the machine zero point
The machine zero point is factory-set to the correct value.

Fig. 69: Checking the machine zero point

Gage required: Clamp with test bore.

To check the machine zero point:

1. Press Extras > Service > Multitest (Multi test).
2. Press Transportklammer (Transport clamp).
3. Assemble the clamp with test bores (1).

4. Press Referenzieren (Referencing).
 The machine moves to the reference position.
5. Press Mittelpunkt (Center point).
 The machine moves to the center position. The needle is positioned 

within the center point bore (2).
The tip of the needle can be lowered into the bore by turning the arm 
shaft crank.

6. Press Test.
 The machine moves to the test position. The center of the needle is 

positioned within the test bore (3).
The tip of the needle can be lowered into the bore by turning the arm 
shaft crank.

(1) - Clamp with test bores
(2) - Center point bore

(3) - Test bore

①

②

③
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Changing the drives
15 Changing the drives

15.1 Changing the sewing motor

15.1.1 Disassembling the sewing motor
To disassemble the sewing motor:

1. Cut off the cable ties.
2. Disconnect the motor cable from the control.
3. Remove the toothed belt cover ( p. 19).

Fig. 70: Disassembling the sewing motor

4. Loosen the screws (6).
5. Remove the toothed belt (1).
6. Pull off the plate (3) with the motor (4).
7. Remove the toothed belt wheel (2).

To do so, loosen the screw on the toothed belt wheel.
8. Loosen the screws (5).
9. Remove the motor (4) from the plate (3).

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before changing the drives.

(1) - Toothed belt
(2) - Toothed belt wheel
(3) - Plate

(4) - Motor
(5) - Screws
(6) - Screws

④

⑥

③

①
⑤②
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15.1.2 Assembling the sewing motor

Fig. 71: Assembling the sewing motor

To assemble the sewing motor:

1. Screw the new motor (4) onto the plate (3) using the screws (5).
2. Assemble the toothed belt wheel (2).

To do so, tighten the screw on the toothed belt wheel.
3. Insert the plate (3) with the motor (4).
4. Slightly tighten the screws (6).
5. Place and tighten the toothed belt (1).

Information
The toothed belt tension is set to the optimum value when the belt oscil-
lates at 284 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

6. Tighten the screws (6).
7. Check if the toothed belt (1) operates in parallel.

If necessary, set parallel operation at the toothed belt wheel.
8. Place the toothed belt cover ( p. 19).
9. Connect the motor plug with the control.

(1) - Toothed belt
(2) - Toothed belt wheel
(3) - Plate

(4) - Motor
(5) - Screws
(6) - Screws

④

⑥

③

①
⑤②
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15.2 Changing the X drive

Fig. 72: Changing the X drive

Disassembling the X drive
To disassemble the X drive:

1. Disconnect both plugs (4).
2. Loosen all 4 screws (1).
3. Pull off the motor and flange (3).

Assembling the X drive
To assemble the X drive:

1. Insert a new motor and flange (3) on to the toothed belt (2).
2. Insert all 4 screws (1) and tighten them loosely.
3. Tension the toothed belt (2) using the screw (5).

Information
The toothed belt tension is set to the optimum value when the belt oscil-
lates at 384 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

4. Tighten all 4 screws (1).
5. Connect the plug (4).

(1) - Screws
(2) - Toothed belt
(3) - Motor with flange

(4) - Plug
(5) - Screw

④

⑤

①

②

③
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15.3 Changing the Y drive

Fig. 73: Changing the Y drive

Disassembling the Y drive
To disassemble the Y drive:

1. Disconnect the plug (1).
2. Unscrew the equipotential bonding (4).
3. Loosen the screw (3) to release the toothed belt (5) tension.
4. Loosen all 4 screws (2).
5. Pull the motor (6) off the flange (7).
6. Pull off the toothed belt wheel.

Assembling the Y drive
To assemble the Y drive:

1. Place the toothed belt wheel onto the new motor. 
2. Insert the motor (6) into the toothed belt (5) and onto the flange (7).
3. Insert all 4 screws (2) and tighten them loosely.
4. Tension the toothed belt (5) using the screw (3) (185 Hz).

Information
The toothed belt tension is set to the optimum value when the belt oscil-
lates at 185 Hz. Check the oscillation, for instance, using a device made 
by Contitech.

5. Tighten all 4 screws (2).
6. Connect the plug (1).

(1) - Plug
(2) - Screws
(3) - Screw
(4) - Equipotential bonding

(5) - Toothed belt
(6) - Motor
(7) - Flange

⑦
④ ⑤ ⑥

①

②

③

85 Service Instructions 911-211-10 - 00.0 - 11/2020



Changing the drives
7. Tighten the equipotential bonding (4).
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16 Checking the play between toothed rack and gear 
wheel

The play between the toothed rack and the gear wheel must be checked 
on both sides of the machine.

Fig. 74: Checking the play between toothed rack and gear wheel

Proper setting
There should be no play between the gear wheel (1) and toothed rack (2).

To check the play between toothed rack and gear wheel:

1. Loosen the screw (4).
2. Turn the nut (3) so that there is no play.
3. Tighten the screw (4).
4. Check the play along the entire length.
 The carriage can be moved without excessive play or stiffness.

(1) - Gear wheel
(2) - Toothed rack

(3) - Nut
(4) - Screw

①

②

③

④
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17 Adjusting the safety release clutch

The safety release clutch disengages in the event of the thread jamming, 
thus separating the upper from the lower shaft and preventing the hook 
from being misadjusted or damaged.

17.1 Engaging the safety release clutch
Proper setting (DELTA)

Fig. 75: Engaging the safety release clutch (1) 

When the safety release clutch is engaged, threaded pins (1) and (2) are 
parallel to each other (figure above).
When the safety release clutch is disengaged, threaded pins (1) and (2) 
are not parallel to each other.

To engage the safety release clutch:

1. Activate bobbin change mode.
2. Clean the sewing area and the area around the hook.
3. Deactivate bobbin change mode.
4. Switch off the machine.
5. Slide the transport carriage to the rear left - use CAUTION with the 

needle and the clamp.

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch the machine to bobbin change mode before 
adjusting the safety release clutch.

(1) - Threaded pins (2) - Threaded pins

①
②
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6. Remove the sliding plate.

Fig. 76: Engaging the safety release clutch (2)

7. Press the button (1) and keep it pressed.
 The pin (2) extends.
8. Press and turn the hand crank until the pin (2) slides into the hole (3).
9. Continue to turn the hand crank until the safety release clutch engages 

with an audible click.
10. Release the button (1).
11. Reinsert the sliding plate.
12. Switch on the machine.

(1) - Button
(2) - Pin

(3) - Hole

①

②

③
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17.2 Adjusting the torque

Fig. 77: Adjusting the torque

Proper setting
The machine is set at the factory such that the torque is 8 Nm when 
the marking point (2) is exactly above the slot (1) of the washer.

To adjust the torque:

1. Swivel up the machine head,  p. 15.
2. Loosen the screw (3).
3. Using a screw driver, turn the washer on the slot (1):

• Increase force: turn in the + direction
• Decrease force: turn in the - direction

4. Tighten the screw (3).

NOTICE

Property damage may occur!
If you change the torque, it could be that the safety release clutch will 
not disengage although this would be required.
This could cause machine damage, e.g. in the event of the thread 
jamming.

Do NOT change the factory adjustment.
Make sure that the torque remains at 8 Nm.

(1) - Slot
(2) - Marking point

(3) - Screw

① ② ③
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18 Programming
Fig. 78: Programming

The control is operated via the control panel OP7000 (1) located on 
the right next to the machine head.

The screen is a touchscreen, i.e. the buttons are displayed on the screen 
rather than provided as physical buttons. Buttons or functions are activat-
ed by tapping the corresponding position on the monitor.

Activating a button/selecting an element:
To activate a button or select an element:

1. Press the corresponding button or element with your finger or a touch-
screen pen.

(1) - Control panel OP7000

①

Service Instructions 911-211-10 - 00.0 - 11/2020 92



Programming
18.1 Structure of the software
You can create and manage seam programs and sequences via software. 
During sewing, these programs are called up and processed stitch by 
stitch. 

Information

Seam program:
A seam program consists of a seam contour with parameters defining 
the individual contour sections.
Up to 99 seam programs can be stored in the system.
Seam programs have a file suffix of .fnp911 after the filename.

Seam sequence:
Up to 30 seam programs can be combined in any order to form a seam 
sequence.
Up to 20 seam sequences can be stored in the system.
Seam sequences have a file suffix of .seq911 after the filename.

The software is also used to define general settings that apply to all pro-
grams. There are also technical menu items for testing and maintaining 
the machine.

18.2 Overview of the menu structure
The following table provides an overview of the menu structure and the 
function buttons on the start screen.

Menu items in popup menus

Menu item Function Sub-items Sub-items Described on
Datei (File) Open existing programs 

for sewing
Create new programs 
and copy or delete 
existing programs.

Löschen (Delete)  p. 127
Kopieren (Copy)  p. 126
Öffnen (Open)  p. 105
Neu (New) Nahtprogramm 

(Seam program)
 p. 112

Nahtsequenz 
(Sewing Sequence)

 p. 123

Speichern unter 
(Save As)

 p. 125

Bearbeiten 
(Edit)

Define general settings 
for all programs or 
modify an existing 
program.

Maschinenparameter 
(Machine parameters)

 p. 128

Sequenz (Sequence)  p. 123
Nahtprogramm (Seam 
program)

Parameter 
(Parameters)

 p. 118

Konturanpassung 
(Contour adjustment)

 p. 116

Konturtest 
(Testing Contour)

 p. 115
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18.3 Starting the software
After it was switched on, the machine performs a reference run. After this, 
the start screen is shown for a few seconds.

Fig. 79: Starting the software (1)

Here you can select the user interface language or use Service to 
quickly access the Multitest (Multi test) menu.

Extras Display options:
fullscreen and zoom

Technician menu: 
Adjustments, system 
information and tests

Vollbild ein/aus 
(Full screen on / off)

 p. 104

Zoom ein/aus 
(Zoom on / off)

 p. 104

Service Einstellungen 
(Settings)

 p. 134

System-Information 
(System information)

 p. 141

Multitest (Multi test)  p. 137
Initialisierung und 
Update (Initialization 
and update)

 p. 142

Manufacturer (for DA personnel only))
Korrektur 
(Corrections)

Shortterm sewing with 
other values

Fadenspannung 
(Thread tension)

 p. 106

Nähdrehzahl (Speed)  p. 107
Buttons on the start screen

Continue sewing the contour from a particular 
point

Reparatur-Modus 
(Repair mode)

 p. 109

Allow for a manual bobbin change Spulenwechsel 
(Bobbin change)

 p. 108

Reset counter to a particular value Zählerreset 
(Reset counter)

 p. 111

Menu items in popup menus

Menu item Function Sub-items Sub-items Described on

(1) - Button language selection (2) - Button Service

① ②
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Information
Both functions can also be selected later from within the program via 
the menu items Extras > Service. 
(See chapters Testing the functions of the machine ( p. 137) and 
Changing the language ( p. 135).)

If you do not press any buttons, the software automatically switches to 
the start screen after a few seconds.

Main screen
The start screen is displayed during sewing. When the machine is started, 
the start screen is opened with the settings of the last sewing program 
used.

Fig. 80: Main screen

Structure of the start screen
• Title bar (1)
This shows the version of the machine on the start screen. It also contains 
information on the menu item currently selected in the various menus.

• Status bar (2)
On the start screen, the seam sequence currently open is displayed here, 
and the time of day (11) is displayed at the right. It also bar contains infor-
mation on the currently selected step in the various menus.

• Main window (3)
The contour to be sewn is displayed here.

(1) - Title bar
(2) - Status bar
(3) - Main window: Display of the 

seam contour
(4) - Program bar
(5) - Menu bar: Popup menu

(6) - Button for resetting the counter
(7) - Button for bobbin change
(8) - Button of the current sewing

parameters
(9) - Button for Repair mode
(10) - Display of time of day

③

④
⑤

⑥
⑦

⑨

⑩

⑧

①
②
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• Program bar (4)
The seam programs of the seam sequence currently open are displayed 
in this line. The program currently being executed is highlighted in black. 
You can use the arrow buttons (6) at the right side of the bar to navigate 
along the bar and display any additional programs that do not fit on the 
bar.
If a seam sequence is not currently open but rather only a single seam pro-
gram, then this program fills the entire bar.

• Menu bar (5)
The bar at the bottom contains the popup menu. This allows you to access 
the various different menu items for creating and editing seam programs 
and for performing settings and tests on the machine. An arrow (1) next to 
a menu entry indicates that pressing the entry will display further sub-items.

Fig. 81: Menu bar

• Button for resetting the counter (6)
This button can be used for resetting the counter for the sewn programs 
or sequences. The current counter value is displayed next to this button.

• Button for bobbin change (7)
This button is used to inform the system that a new bobbin has been in-
serted (e.g. after a color change). The hook thread capacity is displayed 
next to this button.

• Display of the current sewing parameters (8)
The current sewing parameters are displayed below the repair mode 
button:

•  - Seam pattern size

•  - Sewing speed

•  - Thread tension

•  - Stitch length

•  - Number of stitches / hook thread consumed

(1) - Popup arrows

①

Service Instructions 911-211-10 - 00.0 - 11/2020 96



Programming
Information
You can use the buttons Speed, Thread tension and Stitch length to access 
the sewing parameters directly ( p. 118).

• Button for Repair mode (9)
The topmost button at the right side is used for switching the repair mode 
on and off. The current status (On/Off) is displayed next to the button.

18.4 General operation of the software

18.4.1 Entering a password
Depending on the setting (see chapter Changing the password 
options ( p. 134)) a password is only required for accessing the tech-
nical menus or must be entered every time the machine is started. 
Next, the password entry screen is displayed.

Fig. 82: Entering a password

To enter a password:

1. Use the numeric buttons (2) to enter the password.

Information
The default password on delivery is: 25483.
The password can be changed via the Extras menu ( p. 134). 
You can delete incorrect entries via the DEL button.

2. Press the OK button.
 The previously selected menu item opens.

(1) - Input field (2) - Numeric buttons

①

②
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18.4.2 Closing windows
A number of different buttons can be used for closing the currently open 
window.

18.4.3 Display principles

Fig. 83: Display principles

• The currently activated or selected element is highlighted with a dark 
background (2)

• Buttons that are not used in the current context are grayed out (1)

Button Meaning

At the upper right in the title bar of all windows:
 The program jumps back by one navigation level.

OK
CR

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is adopted. 

DEL
Abort

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is discarded. 

(1) - Grayed-out: Deactivated element (2) - Dark background: Activated element

②

①
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18.4.4 Scrolling the display

Fig. 84: Scrolling the display

A scrollbar (1) is displayed on the right when a displayed image is larger 
than the screen height.

To scroll the display:

1. Drag the scrollbar (1) up or down.

18.4.5 Selecting options from a list
When selecting options, a distinction is made between round radio buttons 
and square check boxes.

Selection with radio buttons

Fig. 85: Selection with radio buttons

With round radio buttons only one of the displayed options can be 
selected.

(1) - Scrollbar

①

(1) - Radio buttons: Selected element

①
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To select options using radio buttons:

1. Press the desired option.
 The selected option (1) is marked with a dot.

Selection with check boxes

Fig. 86: Selection with check boxes

Square check boxes allow for the selection of multiple entries.

To select options using check boxes:

1. Press the desired check box.
 The selected entries (1) are marked with a cross.

(1) - Check box: Selected elements

①
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18.4.6 Using file filters

Fig. 87: Using file filters

When opening, copying or deleting seam programs a list of all available 
files is displayed.
You can use the filter functions to make the list more manageable:

To use file filters:

1. Press the Dateifilter (File Filter) button under the list.
 The file filter screen opens.
2. Press the desired filter criterion:

• .fnp911: Seam programs only

• .seq911: Seam sequences only

• All Files: Seam programs and seam sequences
3. Press the Öffnen (Open) button.
 The list is updated according to the selected filter.
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18.4.7 Entering text
A text entry window is displayed when text needs to be entered, e.g. for 
the name of a seam program.

Fig. 88: Entering text

Entering text
To enter text:

1. Use the keyboard (2) displayed to enter the text.

Switching between uppercase/lowercase
To switch between uppercase and lowercase:

1. Press the Aa (5) button.

Deleting the last character
To delete the last character:

1. Press the DEL (4) button.

Adopting the entered text
To adopt the entered text:

1. Press the OK (CR) (3) button.
 The entered text is adopted, and the text entry window is closed.

(1) - Input line
(2) - Keyboard
(3) - OK (CR): Adopt the entered text

(4) - DEL: Delete a character
(5) - Aa: Switching between uppercase/

lowercase

①

②

③
④
⑤
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18.4.8 Entering parameter values
A numeric entry window opens when numeric values for program or 
machine parameters need to be entered.

Fig. 89: Entering parameter values

The title bar (1) shows the parameter group.
The status bar (2) shows the name of the parameter currently being 
edited. The symbol (3) for the corresponding parameter is displayed 
below the parameter name.
The prescribed value range (4) for the parameter is displayed below 
the symbol (3).
The current valid value is displayed in the data entry field (5) below the val-
ue range (4).

Entering a value
To enter a value:

1. Press the desired value using the numeric buttons (6).

Deleting a value
To delete a value:

1. Press the DEL button.

Adopting a value
To adopt a value:

1. Press the OK button.
 The entered value is adopted, and the numeric entry window is 

closed.

(1) - Title bar
(2) - Status bar
(3) - Symbol

(4) - Value range
(5) - Input field
(6) - Numeric buttons

①

②
③
④
⑤

⑥
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18.4.9 Switching the full-screen display on and off
In order to see the seam contour in more detail you can switch the main 
window (1) to occupy the full screen and hide the buttons (2) on the right 
side of the start screen.

Fig. 90: Switching the full-screen display on and off

To switch full-screen on and off:

1. Press the menu items Extras > Vollbild ein/aus 
(Full screen on/off).

 The display switches to the respective mode.

18.4.10 Switching zoom on and off
You can magnify the display in order to see the seam contour in more 
detail. There is only one zoom level that can be switched on or off.

Fig. 91: Switching zoom on and off

To switch zoom on and off:

1. Press the menu items Extras > Zoom ein/aus (Zoom on/
off).

 The display switches to the respective mode.

(1) - Full-screen switched off (2) - Full-screen switched on

① ②

(1) - Zoom switched off (2) - Zoom switched on

① ②
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18.5 Opening a seam program or seam sequence for sewing
To open a seam program or seam sequence for sewing:

1. Press the menu items Datei (File) > Öffnen (Open).
 The file selection screen is displayed.

All existing seam programs and seam sequences are displayed.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 101).

Fig. 92: Opening a seam program or seam sequence for sewing

2. Press the desired file.
3. Press the Öffnen (Open) button.
 The seam program/seam sequence is opened on the start screen.
4. Press the pedal forwards.
 The seam program is sewn.
105 Service Instructions 911-211-10 - 00.0 - 11/2020



Programming
18.6 Briefly sewing with modified values
If you briefly need to with sew a special material or use a particular thread 
strength with different values, without changing the seam program, you 
can use the Korrektur (Correction) menu item to temporarily 
change the values for thread tension and speed. The values then apply to 
all subsequently executed seams until the machine is switched off. 

Important
If you wish to adopt the changes, you must modify and save the program. 
Otherwise, the values are automatically reset to the original settings when 
the machine is switched off. 

18.6.1 Sewing with a modified thread tension
To sew with a modified thread tension:

1. Press the menu items Korrektur (Correction) > 
Fadenspannung (Thread tension).

 The window for changing the thread tension appears:

Fig. 93: Sewing with a modified thread tension

2. Enter the desired value.
3. Press the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.
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18.6.2 Sewing with a modified speed
To sew with a modified speed:

1. Press the menu items Korrektur (Correction) > 
Nähdrehzahl (Sewing speed).

 The window for changing the thread tension appears:

Fig. 94: Sewing with a modified speed

2. Enter the desired speed.
3. Press the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.

18.7 Changing the bobbin/managing a thread breaking

The machine automatically detects when the hook thread has been used 
up and a new bobbin needs to be inserted.

In this case, or if thread breaking occurs, the Fadenriss behandeln 
(Fix thread breaking) window is automatically displayed.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.
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18.7.1 Changing the bobbin

Fig. 95: Changing the bobbin

To change the bobbin:

1. Press the Spulenwechsel (Bobbin change) button.
2. Change the bobbin ( p. 108).
3. Use the Vor (Forwards) and Zurück (Back) buttons to 

move to the point where sewing is to continue.
4. Press the Weiternähen (Continue sewing) button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.

18.7.2 Bobbin change without a request from the program
If you wish to independently insert a new bobbin without being requested 
to do so by the program, then you have to press the Spulenwechsel 
(Bobbin change) button on the start screen.
This will inform the program that a new bobbin has been inserted, causing 
it to resume counting thread consumption starting with the full bobbin ca-
pacity.

18.7.3 Updating the bobbin capacity
To update the bobbin capacity:

1. Press the button Spulenwechsel (Bobbin change)  on the 
start screen.

 The counter for the bobbin capacity begins anew with a full bobbin.
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18.8 Continuing a seam after an error

18.8.1 Continuing a seam in Repair mode after an error
In Repair mode you can move to any desired point on the contour, e.g. in 
order to continue the seam program from this position after an error has 
occurred.

To continue a seam in Repair mode after an error:

1. Press the button Reparaturmodus (Repair mode)  on 
the start screen.

 The Reparaturmodus (Repair mode) window is
displayed.

Fig. 96: Continuing a seam in Repair mode after an error

2. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 
point where sewing is to continue.

OR

3. Use the buttons Vor (Forwards ++) and Zurück (Back ++) to skip to 
the beginning of the next or the beginning of the previous seam section.

4. Press the Weiternähen (Continue sewing) button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.
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18.8.2 Continuing a seam after thread breaking
When the machine was set up, the needle thread monitor mode that 
is supposed to be active was selected in the machine parameters 
(MP 3 ( p. 131)).
In the event of an error, the machine will undo a certain number of preset 
stitches and stop.

The control panel will show the display Fadenriss behandeln (Fix 
thread breaking):

Fig. 97: Continuing a seam after thread breaking

Continuing a seam
To continue a seam after thread breaking:

1. Re-thread the needle thread.
2. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 

point where sewing is to continue.
3. Continue sewing.

Canceling sewing and starting a new seam
To cancel sewing after thread breaking and start a new seam:

1. Press the Abbruch (Cancel) button.
2. Remove the transfer plate.
3. Press the pedal backwards.
 The machine performs a reference run.
4. Press the pedal forwards.
 The machine moves to the loading position, and you can start a new 

seam.
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Checking or changing the bobbin
To change or check the bobbin:

1. Press the Spulenwechsel (Bobbin change) button.
 The display shows a prompt asking whether you wish to reset the 

bobbin counter.
2. Press the Ja (Yes) button if you wish to change the bobbin.
 The bobbin counter will be reset.
OR

3. Press the Nein (No) button if you merely wish to check the bobbin.
 The bobbin counter will not be reset.
4. Remove the transfer plate.
5. Press the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover opens.
6. Change or check the bobbin.
7. Press the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover closes.
8. Press the pedal forwards.
 The machine moves into the insertion position.
9. Insert the transfer plate.
10. Press the pedal or press the Weiternähen (Continue sewing) button.
 The machine moves to the sewing position.
11. Press the pedal or press the Weiternähen (Continue sewing) button.
 The sewing procedure is resumed.

18.9 Resetting the counter
Depending on the set machine parameters, the counter counts the sewn 
programs or sequences up or down. You can use the Zähler-Reset 
(Reset counter) button to reset the counter to the start 
value ( p. 111).

To reset the counter:

1. Press the button Zähler-Reset (Reset counter)  on the start 
screen.

 The counter is reset to the value defined in the machine parameters.
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18.10 Seam programs and seam sequences

18.10.1 Creating a new seam program
New seam programs are created using a Teach-In procedure.
Individual seam paths with specific sewing parameters are defined via 
the control panel in order to do this.

To create a new seam program:

1. Press the menu items Datei (File) > Neu (New) > 
Nahtprogramm (Seam program).

 The Teach-In window appears.

Fig. 98: Creating a new seam program

Defining the starting point
2. Define the starting point:

(1) - Cursor position
(2) - Cursor
(3) - Arrow buttons
(4) - OK button: Accept

(5) - Save button
(6) - Delete button
(7) - Parameter button
(8) - Line selection buttons

②

③ ④
⑤
⑥
⑦

⑧

①

Method Coordinate area

Using the arrow buttons (3)

Caution
For safety reasons, you cannot use the arrow buttons (3) 
to select a position beyond 90.1 or -92.6 on the Y-axis.
Settings beyond these coordinates require that you use 
the pedal.

X -150 to X 230
Y 90.1 to Y -92.6

Using the pedal

Every press of the pedal moves the cursor (2) by 0.1 in 
the direction of the selected axis (X or Y)

X -150 to X 230
Y 100 to Y -100

Entering coordinates directly via the cursor position (1) X -150 to X 230
Y 100 to Y -100
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3. Press the OK (4) button.
 The desired starting point is adopted and marked with a green / blue 

dot.

Selecting the line type
4. Use the line selection buttons (8) to select the type of line to be defined:

•   Seamless path: The clamp moves over this path to the next 
position without sewing

•   Straight seam: A straight path is sewn

•   Curved seam: A curve is sewn

 After pressing the button for a straight or curved seam, the correspond-
ing window for entering the sewing parameters for this path opens.

Defining the sewing parameters for the path

Fig. 99: Defining the sewing parameters for the path

5. Press the desired parameter.
 The window for entering the parameter value opens.
6. Enter the desired value for the parameter ( p. 103).

Sewing parameters for Teach-In
Button Meaning

Speed

Stitch length
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Drawing a path
7. Use the arrow buttons to move the cursor to the end point of the desired 

path.

Information
Alternatively, you can press an arrow button once in order to define the di-
rection and then continue moving in this direction by pressing the pedal.

Important
Take care to ensure that the contour remains within the permissible sew-
ing field of the machine.
Especially with curved paths, you should remember that the start and end 
points are not directly connected and that a curve is generated between 
these two points.

8. Press the OK button.
 The seam path is adopted with the specified parameters.

Adding further seam paths
You can now define all further seam paths in the same manner.

1. Begin every new seam path by selecting the type of line ( p. 113).

Deleting a seam path
1. Press the Löschen (Delete) button.
 The last section of the seam path is deleted. 

Saving a seam program
After you have defined all the seam paths, you can save the seam 
program and specify a name for the program.

Thread tension

Stroke height

Thread cutting

Button Meaning
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1. Press the Speich... (Save...) button.
 The window for entering the name of the seam program opens.
2. Enter the desired name ( p. 102) and adopt the change by pressing 

OK (CR).
 The seam program is now available under this name for sewing, 

editing or copying.
Important
Always perform a contour test after creating a new seam program 
( p. 115).

18.10.2 Performing a contour test
Perform a contour test every time after creating a new seam program or 
editing a seam contour to ensure that the contour you entered lies within 
the permissible sewing field.

To perform a contour test:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturtest (Testing Contour).

 The Konturtest (Testing Contour) window appears.

Fig. 100: Performing a contour test

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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2. Move along the contour stitch by stitch using the Vor (Forwards) and 
Zurück (Back) buttons or the pedal.

3. Check that all points lie within the sewing field.

18.10.3 Editing a seam program
You can change the contour and the sewing parameters of existing seam 
programs. The changes are applied to the seam program that is currently 
open on the start screen.

To edit an existing seam program:

1. Open the seam program you wish to modify via the menu items 
Datei (File) > Öffnen (Open).

 The seam program opens on the start screen.

Changing the contour of a seam program

To change the contour of a seam program:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturanpassung (Contour 
adjustment).

 The contour adjustment window appears:

Fig. 101: Changing the contour of a seam program (1)

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.

(1) - Cursor (2) - Scale: First to last stitch

① ②
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2. Use the arrow buttons to move the cursor (1) to the position on 
the contour that is to be changed.

Information
You can also use the slider control on the scale (2) to select the stitching 
area you wish to change:
The first stitch of the seam pattern is at the top and the last stitch is at 
the bottom.

3. Press the Go To button.
 The selected contour region is displayed in detail.

The stitching point (2) to be modified is marked in red.

Fig. 102: Changing the contour of a seam program (2)

4. Use the arrow buttons to move the stitching point to the new position (4).
 The modified seam path is displayed in green.
5. Press the Weiter (Next) button.
 The window for selecting the technology operations opens.

Fig. 103: Changing the contour of a seam program (3)

(3) - Old stitching point (4) - New stitching point

④

③
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6. Select the desired technology operation(s) for the new seam path 
( p. 99).

7. Confirm the selection with OK.
 You are returned to the detail window with the modified contour.
8. Press the Weiter (Next) button.
 A query dialog is displayed, asking if you wish to adopt the changes.

Confirm the prompt with Ja (Yes) to save the modified contour.
Important
Always perform a contour test after modifying a contour to ensure that the 
new seam path lies within the permissible sewing field ( p. 115).

Changing seam program parameters
You can change the general settings that apply to the entire seam 
program.

To change the seam program parameters:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Parameter (Parameters).

 The window for selecting the program parameter group appears:

Fig. 104: Changing seam program parameters

2. Press the desired parameter group.
 The individual parameters of this group are displayed.
3. Press the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 103).
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There are 8 program parameter groups:

Overview of the individual program parameters

Symbol Parameter group

PP1 - Configuration
General settings

PP2 - Load mode
Load mode and position

PP3 - Deposit mode
Deposit mode and position

PP4 - Soft start
Number of stitches and speed

PP5 - Needle thread monitor
Sensitivity value for the needle thread monitor

PP6 - Thread consumption
Values for determining thread consumption

PP7 - Move:
Contour is moved in a particular direction

PP8 - Scaling: 
Size of the contour is changed.

PP1 - Configuration

Symbol Meaning

Seam name
max. 20 characters

Minimum sewing foot stroke height
(min. = 1.0 .. max. = 10.0; Def. = 5.0 mm)
Sets this as the minimum value of the programmable sewing foot stroke 
height so that only this value needs to be adjusted when sewing thicker 
materials.
Adjust thread tension
(min. = 10… max. = 200; Def. = 100 %)
The thread tension profile for the entire contour is adjusted accordingly. 
A value of 100% means that no adjustments are made.
Adjust empty-run speed
(min. = 10… max. = 200; Def. = 100 %)
The travel speeds are adjusted.

Clamp ID code
Barcode (ID code) of max. 10 characters for performing a safety check 
before the start of sewing (the barcode scanner additional equipment must 
be activated)
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Marking lamps
Up to 4 marking lamps for easier alignment of the sewing material can be 
controlled (the additional equipment must be activated)

Reversal mode 
The following options can be set:
• Not activated: The needle remains at the Stop position
• After the entire contour: After completing all seams in the contour, 

the needle is reversed to the value specified in the machine parameters
• After each seam (Def.): The needle is reversed after every seam
Needle cooling
(On / Off)
Activates/deactivates the needle cooling.

Adjust sewing speed
(min. = 10… max. = 200; Def. = 100%)
The sewing speed is adjusted by the specified percent value.

PP2 - Load mode

Symbol Meaning

Load mode
The following options can be set:
• Mode 1 (Def.)
The clamp is opened in the loading position. The clamp is closed when the 
pedal is pressed. Pressing the pedal again starts the sewing of the seam.
• Mode 2
The clamp is opened in the loading position. Pressing the pedal closes 
the left part of the two-piece clamp for angle mounting. Pressing the pedal 
again closes the right part. Another press of the pedal starts the sewing of 
the seam.
• Mode 3
The clamp is opened in the loading position. Pressing the pedal closes 
the right part of the two-piece clamp for angle mounting. Pressing the pedal 
again closes the left part. Another press of the pedal starts the sewing of 
the seam.
• Mode 4
Quick-start mode:
The clamp is opened in the loading position. The clamp is closed, and the 
sewing of the seam is started when the pedal is pressed. With the alternat-
ing clamp, the seam is automatically started after insertion.
This mode is only active when quick-start is activated in the machine 
parameters. The machine must be switched off and on in order to activate 
the quick-start mode.
• Mode 5
The clamp remains closed in the loading position. Pressing the pedal again 
starts the sewing of the seam.
Loading position
(On / Off)
With the loading position activated the clamps move to the desired position 
for convenient insertion of the sewing material.

Symbol Meaning
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Loading position X
The value range varies depending on the subclass and sewing field size.

 Loading position Y
The value range varies depending on the subclass and sewing field size.

PP3 - Deposit mode

Symbol Meaning

Deposit mode
The following options can be set:
• Mode 1 (Def.)
Clamp is opened in the removal position.
• Mode 2
The clamp remains closed in the removal position. The clamp is opened 
when the pedal is pressed. 
• Mode 3
The clamp remains closed in the removal position. Pressing the pedal 
opens the left part of the two-piece clamp for angle mounting. 
Pressing the pedal again opens the right part.
• Mode 4
The clamp remains closed in the removal position. Pressing the pedal 
opens the right part of the two-piece clamp for angle mounting. 
Pressing the pedal again opens the left part.
• Mode 5
Clamp remains closed in the removal position.
Removal position
(On / Off)
With the removal position activated the clamps move to the desired 
position for convenient removal of the sewing material after the sewing 
procedure.
Removal position X 
The value range varies depending on the subclass and sewing field size.

Removal position Y 
The value range varies depending on the subclass and sewing field size.

Symbol Meaning
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PP4 - Soft start

Symbol Meaning

Soft-start stitch count
(min. = 0.. max. = 10; Def. 5)

Soft-start speed
 (min. = 100 .. max. = 2000; Def. 300 rpm)

PP5 - Needle thread monitor

(min. = 0 .. max. = 99; Def. 5)
Only active if activated in the machine parameters.
(A higher value makes the needle monitor less sensitive. 
99 = Needle thread monitor switched off in this program only.)

PP6 - Thread consumption

Symbol Meaning

Sewing material thickness (min. = 0.. max. = 20.0; Def. 0)
 The thickness of the sewing material when pressed together.

Adjust thread consumption
 (min. = -10.0.. max. = 10.0; Def. 0)
 Correction of the calculated values.

PP7 - Move

Symbol Meaning

X move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

Y move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)
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18.10.4 Creating a new seam sequence
You can combine up to 30 seam programs to form a seam sequence. 
You can create up to 20 seam sequences in total.

Selecting seam programs
To select seam programs:

1. Press the menu items Datei (File) > Neu (New) > Sequenz 
(Sequence).

 The window for selecting the seam program appears.

Fig. 105: Selecting seam programs

The existing seam programs are displayed at the right side of the screen. 
The Sequenz (Sequence) field on the left shows which seam 
programs have been transferred to the seam sequence.

PP8 - Scaling.

Symbol Meaning

X scaling 
(min. = 80… max. = 120; Def. = 100 %)
100% corresponds to the original size.

Y scaling 
(min. = 80… max. = 120; Def. = 100 %)

X scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)

Y scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)
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2. Press the desired seam program.
 The selected seam program is highlighted with a dark background.
3. Press the Einfügen (Insert) button.
 The seam program is transferred to the seam sequence and is 

displayed in the Sequenz (Sequence) field on the left side 
of the screen.

4. Add further seam programs in the same manner.

Removing a seam program from a seam sequence
To remove a seam program from a seam sequence:

1. Press the seam program in the Sequenz (Sequence) field 
and then press the Löschen (Delete) button.

 The seam program is removed from the seam sequence.

Assigning a name to a seam sequence
To assign a name to a seam sequence:

1. Press the Namen eingeben (Set name) button.
 The window for entering the name of the seam sequence opens.
2. Enter the desired name and adopt the change by pressing 

OK(CR) ( p. 102).
 The seam sequence is now available under this name for sewing, 

editing or copying.

18.10.5 Editing a seam sequence
You can edit an existing seam sequence by adding or removing seam 
programs.

To edit a seam sequence:

1. Open the seam program you wish to modify via the menu items 
Datei (File) > Öffnen (Open).

 The seam sequence opens on the start screen.
2. Press the menu items Bearbeiten (Edit) > Sequenz 

(Sequence).
 The window for editing the seam sequence appears.
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Fig. 106: Editing a seam sequence

3. Use the buttons Einfügen (Insert) and Löschen (Delete) to add 
programs to the seam sequence or remove programs from the seam 
sequence.

18.10.6 Saving a seam program or seam sequence under a different 
name

You can also save existing seam programs or seam sequences under a 
different name.

Information
If you wish to create a new program that is similar to an existing program, 
you do not need to create the entire program anew. You can save the 
existing program under a new name and then change the details you wish 
to modify.

To save a seam program or a seam sequence under a different name:

1. Press the menu items Datei (File) > Speichern unter 
(Save As).

 A selection window allowing you to select a seam program or seam 
sequence appears.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 101).

2. Press the desired element.
3. Press the Speichern unter (Save As) button.
 The window for entering the new name is opened.
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4. Enter the desired name and adopt the change by pressing 
OK(CR) ( p. 102).

 The seam program or seam sequence is now available under this 
name for sewing, editing or copying.

18.10.7 Copying a seam program or seam sequence
You can also copy seam programs or seam sequences from a USB key 
to the control or from the control to a USB key.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler.

To copy a seam program or a seam sequence:

1. Press the menu items Datei (File) > Kopieren (Copy).
 The window for selecting the file to be copied appears:

Fig. 107: Copying a seam program or seam sequence

2. Use the buttons (1) to select whether the data is to be copied from 
the DAC control or the USB key.

 The selected button is highlighted with a dark background.
The files present at this location are listed in a selection window (2).

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 101).

3. Press the desired file.
 The selected file is highlighted with a dark background.
4. Press the Datei kopieren (Copy File) button.
 The selected file is copied to the USB key or the control.

(1) - Select the source to be copied (2) - File selection window

① ②
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18.10.8 Deleting a seam program or seam sequence
Seam programs or seam sequences that are no longer required can be 
deleted from the control.

To delete a seam program or a seam sequence:

1. Press the menu items Datei (File) > Löschen (Delete).
 The window for selecting the file to be deleted appears:

Fig. 108: Deleting a seam program or seam sequence

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 101).

2. Press the desired file.
 The selected file is highlighted with a dark background.
3. Press the Löschen (Delete) button.
 The selected file is deleted.
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18.11 Editing machine parameters
You use the machine parameters to define the basic machine settings.
These basic settings apply to all programs.

To edit the machine parameters:

1. Press the menu items Bearbeiten (Edit) > Maschinen-
parameter (Machine parameters).

 The window for selecting the machine parameter group appears.

Fig. 109: Editing machine parameters

2. Press the desired parameter group.
 The individual parameters of this group are displayed.
3. Press the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 103).

There are 6 machine parameter groups:

Symbol Parameter group

MP1 - Configuration
General settings

MP2 - Limit values
Limit values for speeds and positions

MP3 - Needle thread monitor
Behavior after thread breaking

MP4 - Thread cutting
Speed, position and tension

MP5 - Thread clamping
Starting angle

MP6 - Counters
Settings for program and bobbin counters
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Overview of the individual machine parameters

MP1 - Configuration

Symbol Meaning

Needle cooling 
The following options can be set:
• Without: No needle cooler activated.
• Air cooling (Def.): The needle is cooled with air while sewing the seam
• Ice cooling: Optional equipment
Sewing foot mode
The sewing foot can be operated in the following modes:
• Jumping foot: The sewing foot only presses on the sewing material 

while the needle is in the sewing material
• Presser foot: The sewing foot presses continuously on the sewing 

material
Sewing field size 
Take care to ensure a valid sewing field size for your subclass when 
making the selection! (See chapter Technical data ( p. 168))
• Normal sewing field (Def.): A sewing field of up to 200 x 300mm is 

available
• Extra-large sewing field: A larger sewing field can be used in 

conjunction with the alternating clamps
Optional equipment 
• Reduced clamp pressure: Optional equipment limiting the amount of 

clamp pressure to allow for better alignment on insertion. 
• Neat seam beginning: Optional equipment, activates stitch position 

optimization ( Additional Instructions Stitch Position Optimization)
• Marking lamps: Optional equipment providing orientation lines on 

insertion for easier alignment. Up to 4 marking lamps can be switched on 
for each program. This setting only activates the option, the actual 
switching is defined in the program parameters (see Marking lamps 
( p. 120)) 

• Barcode scanner: Optional equipment for performing a safety check 
before sewing. A barcode can be stored with each program. Agreement 
with the barcode on the clamp is checked. Sewing only proceeds when 
the barcodes agree. You enter the barcode ID in the program parameters 
(see Clamp ID code ( p. 119)).

Clamp type 
The following clamp types are available:
• Single clamp: One-piece parallel clamp with angle mount
• Single clamp with hanger (Def.): One-piece parallel clamp with hanger 

mount
• Double clamp: Two-piece parallel clamp with angle mount
• Alternating clamp: Removable clamp
• Special clamp: Special clamp
Clamp limitation 
• Preset limitation (Def.): No additional structures are taken into account
• Special limitation: Individual limits are taken into account
129 Service Instructions 911-211-10 - 00.0 - 11/2020



Programming
Information
The remaining thread monitor (MP 1, Optional equipment) and the bobbin 
counter (MP 6) can be activated simultaneously. The display shows 
the two options as follows:

Fig. 110: Remaining thread monitor and bobbin counter

Pedal mode 
The following options are available:
• Mode 1: The current position of the pedal is evaluated
• Mode 2 (Def.): The pedal must be returned to the initial position after 

every press before a new press is recognized
• Mode 3: The current position of the pedal is evaluated. The quick-start 

mode is also enabled (see Load mode ( p. 120)). The machine must 
be switched off and on in order to activate the quick-start mode.

• Push button: In push button mode one sensor is used only for 
controlling the clamp motion (up and down). The other sensor is used for 
starting the sewing process.

Barcode mode
The following options are available:
• Manual: Machine checks whether the inserted clamp matches the 

entered seam program. If the clamp is correct, the machine is ready for 
sewing. If the clamp is incorrect, an error message will be displayed, 
and the clamp will have to be replaced.

• Automatic: The machine looks for the seam program that matches the 
inserted clamp. The machine is ready for sewing once the seam program 
has been selected.

Symbol Meaning

(1) - Display - remaining thread monitor:
Remaining thread monitor active:
R shown
Remaining thread monitor inactive:
R hidden

(2) - Display - bobbin counter:
Bobbin counter active:
Number black
Bobbin counter inactive:
Number grayed-out

① ②
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MP2 - Limit values

Symbol Meaning

Max. speed 
(min. = 500 .. max. = 2700; Def. 2700 rpm)
All sewing programs are limited to this maximum speed

Max. run-empty speed 
(min. = 10 .. max. = 100; Def. 100 %)
Limits all clamp movements between the seams to this value

Feed starting angle 
(min. = 30 .. max. = 350; Def. 210 degrees)
The clamp motion during the stitch starts at this angle of needle motion

Feed phase 
(min. = 30 .. max. 100; Def. 80 %)
This parameter defines how the clamp is to be moved during the stitch. 
(A value of 100 % means that the desired clamp motion is distributed over 
the entire stitch.)
Reversal position 
(min. = 0 .. max. 359; Def. 0 degrees)
The needle is reversed at this angle in order to increase the clearance to 
the clamp.
 Edit times and routes
 This function is only for Dürkopp Adler Service personnel

MP3 - Needle thread monitor

Symbol Meaning

Needle thread monitor mode
The following options are available:
• Threading position: After detection of a thread breaking, the thread is 

cut, and the clamp then moves to the threading position
• Thread cutting (Def.): After detection of a thread breaking, the thread is 

cut, and the clamp then moves to the contour position according to the 
defined reversing path

• Pausing: After detection of a thread breaking, seam motion is stopped
• Not activated: The needle thread monitor is ignored
Reversing path after thread breaking 
(min. = 0 .. max. 20; Def. 5 stitches)
Number of stitches to be taken into account when reversing after a thread 
breaking
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Position of bobbin change X 
The value range varies depending on the subclass and sewing field size

Position of bobbin change Y 
The value range varies depending on the subclass and sewing field size

MP4 - Thread cutting

Symbol Meaning

Cutting speed 
(min. = 70 .. max. 500; Def. 180 rpm)
Speed of the cutting stitch

Cutting position on 
(min. = 0° .. max. 359°; Def. 180°)
Angular position of the needle at which the thread cutting knife is switched 
on
Cutting position off
(min. = 0° .. max. 359°; Def. 359°)
Angular position of the needle at which the thread cutting knife is switched 
off
Thread tension during thread cutting 
(min. = 00 .. max. 100; Def. 10 %)
Thread tension of the cutting stitch

Position for thread tension during thread cutting 
(min. = 0° .. max. 400°; Def. 370°)
Starting angle for the thread tension during the cutting stitch
(At an angle greater than 359° the thread tension is activated in the next 
stitch.)

MP5 - Thread clamping

Symbol Meaning

Close thread clamp at 1st stitch 
(min. = 0° .. max. 250°; Def. 180°)
Start angle for closing the thread clamp during the first stitch

Open thread clamp at 1st stitch 
(min. = 0° .. max. 359°; Def. 340°)
Starting angle for opening the thread clamp during the first stitch.
If the closing and opening angles are the same then the thread clamp is not 
activated

Symbol Meaning
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Information
The remaining thread monitor (MP 1, Optional equipment) and the bobbin 
counter (MP 6) can be activated simultaneously. The display shows the 
two options as follows:

Fig. 111: Remaining thread monitor and bobbin counter

MP6 - Counters

Symbol Meaning

Counter type 
The following options are available:
• Increment counter (Def.): The counter is incremented after each sewn 

program
• Decrement counter: The counter is decremented after each sewn 

program
• Increment seam sequence counter: The counter is incremented after 

each seam sequence sewn
• Decrement seam sequence counter: The counter is decremented after 

each seam sequence sewn
Reset value for the counter
(min. = 0 .. max. 9999; Def. 0)
Value to which the counter is set when a counter reset is performed

Adjust seam count for bobbin reserve
(min. = 0 .. max. 100; Def. 0)
A message is displayed to the user after the number of seams specified 
here have been sewn. A value of 0 deactivates the function
Bobbin supply capacity
(min. = 0.0 .. max. 400.0; Def. 0.0 m)
A message is displayed to the user after the bobbin supply capacity has 
been consumed. A value of 0 deactivates the function

(1) - Display - remaining thread monitor:
Remaining thread monitor active:
R shown
Remaining thread monitor inactive:
R hidden

(2) - Display - bobbin counter:
Bobbin counter active: Number black
Bobbin counter inactive:
Number grayed-out

① ②
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18.12 Checking and changing the technical settings
The technical settings are made via the menu item Extras > Ser-
vice.

Fig. 112: Checking and changing the technical settings

Important
A password must always be entered in order to access the additional 
menu items in Extras > Service ( p. 97).

18.12.1 Changing the password options
The default password on delivery is: 25483.

You can change this password and also define whether the password 
only applies to the technical menu items or must always be entered after 
the machine is switched on.

Changing the password
To change the password:

1. Press the menu items Extras > Service > Einstellungen 
(Adjustments).

 The Einstellungen (Adjustments) window appears.

2. Press the Operator Passwort (Operator Password) 
option.

3. In the following window press the option Passwort ändern 
(Change password).

 The window for entering the new password appears.
4. Enter the new password ( p. 97).
Important
The password must not have more than 5 digits.

5. Confirm the new password with OK.
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Defining the password protected areas
To define the password protected areas:

1. Press the menu items Extras > Service > Einstellungen 
(Adjustments).

 The Einstellungen (Adjustments) window appears.

2. Press the Operator Passwort (Operator Password) 
option.

 In the next window the Aktivieren/Deaktivieren 
(Activate/Deactivate) option indicates the type of pass-
word protection:

•   - Comprehensive password protection activated: 
Password protection of the first action after switching on

•   - Comprehensive password protection deactivated:
Password protection for the technical menu items only 

3. Press the Aktivieren/ Deaktivieren (Activate/
Deactivate) option to switch between each respective setting.

4. Confirm with OK.
Important
Switch off and on again the machine to adopt the setting.

18.12.2 Changing the language
To change the language:

1. In the menu item Extras > Service > Einstellungen 
(Adjustments) press the Sprache (Language) option.

 The list of available languages is displayed.
2. Press the desired language.
3. Confirm with OK.
 The screen is reloaded in the selected language.

18.12.3Setting date and time
To set date and time:

1. In the menu item Extras > Service > Einstellungen 
(Adjustments) press the option Datum und Uhrzeit 
(Date and time).

 The data entry window for date and time is displayed.
2. Enter the date and/or time.
3. Confirm with OK.
 The entered values are adopted.
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18.12.4 Setting the brightness
To set the brightness:

1. In the menu item Extras > Service > Einstellungen 
(Adjustments) press the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window press the Kontrast (Contrast) 
Helligkeit (Brightness) option.

 A window with slider controls is displayed.
3. Pull the corresponding slider control up or down to change the value.
 The changes are immediately visible on the display.

18.12.5 Testing the touchscreen
You can use the Extras > Service > Einstellungen 
(Adjustments) menu item to check that the touchscreen is 
functioning correctly over all areas of the screen.

To test the touchscreen:

1. In the menu item Extras > Service > Einstellungen 
(Adjustments) press the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window press the Touch Test option.
 An empty window is opened.
3. Use your finger to press various different points or draw lines.
 When the touchscreen is functioning correctly all touched points of 

the screen are marked.
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18.13 Testing the functions of the machine
You can use the Extras > Service > Multitest (Multi 
test) menu item to check the inputs and outputs, test the sewing motor 
and set the stroke position.

Fig. 113: Testing the functions of the machine

Information

The functions  Transport clamp and  Thread burner 
are only intended for use by Dürkopp Adler Service personnel.

18.13.1 Test inputs and outputs
Important
The instructions only provide an overview of the test possibilities.

The tests may only be performed by qualified specialists that have 
received training from Dürkopp Adler.

To test inputs and outputs:

1. In the menu item Extras > Service > Multitest 
(Multi test) press the Eingänge/Ausgänge testen 
(Test inputs / outputs) option.

 The IO-Testseite (IO Test Page) window is displayed.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do NOT reach into the machine during function 
testing of inputs and outputs.
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Fig. 114: Test inputs and outputs

The input elements are listed and selected at the left side (1) and the 
output elements at the right side (2).

2. For the 1st time: Press the button selected: and select an output.

3. Next, use Auswahl + (Select +) or Auswahl - 
(Select -) to select the desired element 
in the respective area.

 The number of the element is displayed on the ausgewählt: 
(selected:) button.

4. Test the element using the Ein/Aus (On/Off) or 
umschalten (Toggle) buttons, depending on the type of 
the input or output element.

(1) - Area for input elements (2) - Area for output elements

① ②

Input elements

No. Meaning

S1 Lower right clamp
S2 Lower left clamp
S9 Needle thread monitor active
S10 Hook cover closed
S11 Machine head latch closed
S13 Pedal forwards
S14 Pedal backwards
S16 Pressure switch
S17 Quick-stop
S100 Sewing motor reference
S101 X-axis reference
S102 Y-axis reference
S103 Z-axis reference
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18.13.2 Adjusting the stroke position

To adjust the stroke position:

1. In the menu item Extras > Service > Multitest 
(Multi test) press the Hublage einstellen 
(Set stroke position) option.

 The following options are displayed:

Output elements

No. Meaning

Y1 Foot mode
Y2 Hook cover
Y3 Needle cooling on
Y4 Right clamp
Y5 Left clamp
Y9 Threading switch lamp on
Y10 Oil level indicator warning light on
Y11 Burner transformer on
Y12 Upper burner
Y13 Lower burner
Y14 Thread suction device
Y25 Marking lamp 1 (Z)
Y26 Marking lamp 2 (Z)
Y27 Marking lamp 3 (Z)
Y28 Marking lamp 4 (Z)

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine when setting the 
stroke position.
Switch off the power to the drives when you wish to 
test the freedom of motion of the sewing foot rod.
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2. Press the desired symbol and execute the function.

18.13.3Testing the sewing motor

To test the sewing motor:

1. In the menu item Extras > Service > Multitest (Multi 
test) press the Nähmotor testen (Test sewing 
motor) option.

 The sewing motor test screen is displayed:

Fig. 115: Testing the sewing motor

Symbol Meaning

Perform a reference run
Check the movement

Switch between jumping foot and presser foot
Switch over the mode of operation

Go to position
Adjust the sewing foot height

Switch off the power to the drives
Manually check the freedom of motion of the sewing foot rod

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine during the function 
test of the motor.
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Important
Remove the thread from the needle and the thread lever before starting 
the test.

2. Press the  button.

 The window for entering the speed opens.
3. Enter the desired value (300 - 2000 rpm).

4. Press the  button.

 The window for entering the cutting speed opens.
5. Enter the desired value (70 - 500 rpm).

6. Press the  button.

 The sewing motor runs at the entered speed.

7. Press the  button.

 The sewing motor stops.

8. Press the  button.

 The sewing motor runs at the entered speed.

9. Press the  button.

 The sewing motor stops, and the thread trimmer is actuated.

18.13.4 Calling up log displays and error lists
You can access the log settings and error lists via Extras > Service > 
System-Information (System information).

To call up log displays and error lists:

1. Press the menu items Extras > Service > System-
Information (System information).

 The selection screen for system information appears.

Fig. 116: Calling up log displays and error lists
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2. Press the desired symbol.

18.14 Initializing the control and performing updates
You can use Extras > Service > Initialisierung und 
Update (Initialization and Update) to reset the control 
and control panel to the factory defaults and to update the control with 
a new software version.

To initialize the control and perform updates:

1. Press the menu items Extras > Service > Initialisierung 
und Update (Initialization and Update).

 The screen for initialization and update appears.

Fig. 117: Initializing the control and performing updates

Symbol Meaning

Control unit events
List of the latest errors

Log configuration
Only for Dürkopp Adler Service personnel

Log display
List of the last log settings

State of control panel
Status appears in the log display
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18.14.1 Initializing the control
Important
Initializing the control resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

Order
Save your seam programs and seam sequences to a USB key before 
performing initialization.

1. Press the Initialisierung der Steuerung 
(Initialization Control) option.

 The control is completely reset to the factory default settings.

18.14.2 Initializing the control panel
Important
Initializing the control panel resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

1. Press the Initialisierung des Bedienfelds 
(Operation panel   initialization) option.

 The control panel is completely reset to the factory default settings.

18.14.3Performing an update of the control

Information
The latest software version is available in the download area at
www.duerkopp-adler.com.

You can easily transfer a new software version from a USB key to 
the control.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler.

To perform an update of the control:

1. Switch off the machine.
2. Insert the USB key into the USB port (1) on the control panel.
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Fig. 118: Performing an update of the control

3. Switch on the machine.
 The software update is performed automatically.

Information
If the automatic update does not function then you can use the menu items 
Extras > Service > Initialisierung und Update 
(Initialization and Update) > Update der Steuer-
ung (Update the control) to load a specific software version.

Contact the Dürkopp Adler Service Hotline for this.

Displaying software version information
The menu item ? displays information on the software currently installed 
on the machine.

To display information on the software version currently used:

1. Press menu items ? > Press on Info.
 The following information is displayed:

• Class
• Subclass
• Software version
• Date of creation of this software version

18.15 DA CAD professional
You can use the DA-CAD professional program to create seam programs 
on a PC ( Operating Instructions DA CAD professional).

(1) - USB port

①
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19 Maintenance

This chapter describes maintenance work that needs to be carried out 
on a regular basis to extend the service life of the machine and achieve 
the desired seam quality.

Advanced maintenance work may only be carried out by qualified special-
ists ( Service Instructions).

Maintenance intervals

WARNING
Risk of injury from sharp parts!
Punctures and cutting possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

WARNING
Risk of injury from moving parts!
Crushing possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

Work to be carried out Operating hours

8 40 160 500

Cleaning

Removing sewing dust and thread residues 

Cleaning the motor fan mesh 

Lubricating

Lubricating the machine head 

Lubricating the hook 

Servicing the pneumatic system

Adjusting the operating pressure 

Draining the water condensation 

Cleaning the filter element 

Servicing specific components

Checking the toothed belt 
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19.1 Cleaning

19.1.1 Cleaning the machine
Sewing dust and thread residues should be removed after every 8 operat-
ing hours using a compressed air gun or a brush. If very fluffy sewing ma-
terial is being sewn, the machine must be cleaned more frequently.

Fig. 119: Cleaning the machine

WARNING
Risk of injury from flying particles!
Flying particles can enter the eyes, causing injury.

Wear safety goggles.
Hold the compressed air gun so that the particles 
do not fly close to people.
Make sure no particles fly into the oil pan.

NOTICE

Property damage from soiling!
Sewing dust and thread residues can impair the operation of 
the machine.

Clean the machine as described.

NOTICE

Property damage from solvent-based cleaners!
Solvent-based cleaners will damage paintwork.

Use only solvent-free substances for cleaning.

(1) - Area around the needle
(2) - Hook

(3) - Area under the throat plate
(4) - Knife on the winder

①

② ③

④
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Areas particularly susceptible to soiling:
• Knife on the winder (4)
• Area under the throat plate (3)
• Hook (2)
• Area around the needle (1)

To clean the machine:

1. Remove any dust and thread residues using a compressed air gun or 
a brush.

19.1.2 Cleaning the motor fan mesh
The motor fan mesh must be cleaned once a month using a compressed 
air gun. If very fluffy sewing material is being sewn, the motor fan mesh 
must be cleaned more frequently.

Fig. 120: Cleaning the motor fan mesh 

To clean the motor fan mesh:

1. Remove any sewing dust and thread residues using a compressed air 
gun.
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19.2 Lubricating

The machine is equipped with a central oil-wick lubrication system. 
The bearings are supplied from the oil reservoir.

For topping off the oil reservoir, use only lubricating oil DA 10 or oil of 
equivalent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s
• Flash point: 150 °C
You can order the lubricating oil from our sales offices using the following 
part numbers:

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.

NOTICE

Property damage from incorrect oil!
Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions.

CAUTION
Risk of environmental damage from oil!
Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil.
Dispose of used oil and oily machine parts in 
accordance with national regulations.

Container Part no.

250 ml 9047 000011

1 l 9047 000012

2 l 9047 000013

5 l 9047 000014
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19.2.1 Lubricating the machine head
Proper setting
The oil level is between the minimum level marking and the maximum 
level marking.

Fig. 121: Lubricating the machine head

To lubricate the machine head:

1. Check the oil level indicator every day.
2. If the oil level is below the minimum level marking (3):

Top off oil through the refill opening (1) but no higher than the maximum 
level marking (2).

(1) - Refill opening
(2) - Maximum level marking

(3) - Minimum level marking

①

②

③

Service Instructions 911-211-10 - 00.0 - 11/2020 150



Maintenance
19.2.2 Lubricating the hook
The approved oil quantity for hook lubrication is a factory specification. 

Proper setting
1. Hold a piece of blotting paper next to the hook (1) while sewing.
 After sewing a stretch of approx. 1 m, the blotting paper will have 

been sprayed with a thin and even film of oil.

Fig. 122: Lubricating the hook

To lubricate the hook:

1. Turn the screw (2):
• more oil: turn counterclockwise
• less oil: turn clockwise

Important
The released amount of oil does not change until the operating time has 
run a few minutes. Sew for several minutes before you check the setting 
again.

(1) - Hook (2) - Screw

①

②
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19.3 Servicing the pneumatic system

19.3.1 Adjusting the operating pressure

Proper setting
Refer to the Technical Data ( p. 168) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Check the operating pressure on a daily basis.

Fig. 123: Adjusting the operating pressure

To adjust the operating pressure:

1. Pull the pressure regulator (1) up.
2. Turn the pressure regulator until the pressure gage (2) indicates 

the proper setting:
• Increase pressure = turn clockwise
• Reduce pressure = turn counterclockwise

3. Push the pressure regulator (1) down.

NOTICE

Property damage from incorrect adjustment!
Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure regulator (2) - Pressure gage

①

②
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19.3.2 Draining the water-oil mixture

The collection tray (2) of the pressure regulator will show accumulation of 
a water-oil mixture.

Proper setting
The water-oil mixture must not rise up to the level of the filter element (1).

Check the level of the water-oil mixture in the collection tray (2).

Fig. 124: Draining the water-oil mixture

To drain the water-oil mixture:

1. Disconnect the machine from the compressed air supply. 
2. Place the vessel under the drain screw (3).
3. Loosen the drain screw (3) completely.
4. Allow the water-oil mixture to drain into the vessel.
5. Tighten the drain screw (3).
6. Connect the machine to the compressed air supply.

NOTICE

Property damage from excess liquid!
Too much liquid can result in damage to the machine.

Drain liquid as required.

(1) - Filter element
(2) - Collection tray

(3) - Drain screw

①

② ③
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19.3.3 Cleaning the filter element

Fig. 125: Cleaning the filter element

To clean the filter element:

1. Disconnect the machine from the compressed air supply.
2. Drain the water-oil mixture ( p. 153).
3. Unscrew the collection tray (2).
4. Unscrew the filter element (1).
5. Blow out the filter element (1) using the compressed air gun.
6. Wash out the filter tray using benzine.
7. Tighten the filter element (1).
8. Tighten the collection tray (2).
9. Tighten the drain screw (3).
10. Connect the machine to the compressed air supply.

NOTICE

Damage to the paintwork from solvent-based cleaners!
Solvent-based cleaners damage the filter. 

Use only solvent-free substances for washing out the filter tray.

(1) - Filter element
(2) - Collection tray

(3) - Drain screw

①

② ③
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19.4 Servicing specific components

19.4.1 Checking the toothed belt

The condition of the toothed belt must be checked once a month.

Important
A damaged toothed belt must be replaced immediately.

Proper setting
• The toothed belt exhibits no cracks or fragile areas
• When pressed with a finger, the toothed belt must yield no more than 

10 mm.

19.4.2 Checking the thread suction device
Proper setting
The thread is sucked in properly.
Check on a regular basis if the thread suction device sucks in the thread 
properly without the walls of the hose sticking together.

To check the thread suction device:

1. As soon as the thread is no longer sucked in properly, blow talcum 
powder into the hose through the opening of the thread suction device.

19.5 Parts list
A parts list can be ordered from Dürkopp Adler. Or visit our website for 
further information at:

www.duerkopp-adler.com

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before checking the 
condition of the toothed belt.
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20 Decommissioning

To decommission the machine:

1. Switch off the machine.
2. Unplug the power plug.
3. If applicable, disconnect the machine from the compressed air supply.
4. Remove residual oil from the oil pan using a cloth.
5. Cover the control panel to protect it from soiling.
6. Cover the control to protect it from soiling.
7. Cover the entire machine if possible to protect it from contamination 

and damage.

WARNING
Risk of injury from a lack of care!
Serious injuries may occur.

ONLY clean the machine when it is switched off.
Allow ONLY trained personnel to disconnect the 
machine.

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash 
the affected areas thoroughly.
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21 Disposal

The machine must not be disposed of in the normal household waste.

The machine must be disposed of in a suitable manner in accordance with 
all applicable national regulations.

When disposing of the machine, be aware that it consists of a range of 
different materials (steel, plastic, electronic components, etc.). Follow the 
national regulations when disposing these materials.

CAUTION
Risk of environmental damage from improper 
disposal!
Improper disposal of the machine can result in 
serious environmental damage.

ALWAYS comply with the national regulations 
regarding disposal.
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22 Troubleshooting

22.1 Customer Service
Contact for repairs and issues with the machine:

Dürkopp Adler GmbH
Potsdamer Str. 190
33719 Bielefeld, Germany

Tel. +49 (0) 180 5 383 756
Fax +49 (0) 521 925 2594
Email: service@duerkopp-adler.com
Internet: www.duerkopp-adler.comError and information messages
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22.2 Messages of the software

Error 
code Description Troubleshooting

Sewing motor

1051 Sewing motor timeout
• Cable to sewing motor reference

switch defective
• Reference switch defective
• Machine head does not move freely 

or has excessive belt tension

• Replace cable

• Replace the reference switch
• Check the ease of movement and 

belt tension of the machine head

1052 Sewing motor excess current
• Sewing motor cable defective
• Sewing motor defective
• Control defective

• Replace sewing motor cable
• Replace sewing motor
• Replace control

1053 Sewing motor mains voltage too high Check mains voltage

1055 Sewing motor overload
• Sewing motor blocked/not moving 

freely
• Sewing motor defective
• Control defective

• Fix blockage/sluggishness
• Check the sewing motor
• Check the control

1056 Sewing motor overtemperature
• Sewing motor not moving freely
• Sewing motor defective
• Control defective

• Eliminate seizing
• Replace sewing motor
• Replace control

1058
1302
1342

1344 

Sewing motor speed
• Sewing motor defective
Sewing motor error
Control not receiving pulses from 
pulse encoder in motor
Sewing motor error
Internal error 

• Replace sewing motor
• Check the cable from the pulse 

encoder in the motor to the control
• Switch off and on the machine 

again
• Software update

Stepper motors

2101 X-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Cable to reference switch defective
• Reference switch defective

• Align reference switch
• Replace cable
• Check reference switch

2102 X-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace stepper motor

2152 X-axis stepper motor excess current • Replace stepper motor
• Replace control

2153 X-axis stepper motor overvoltage
• Mains voltage too high

• Check mains voltage
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2155 X-axis stepper motor overload
• Feed system not moving freely
• Obstacle to feed movement

• Eliminate sluggishness
• Remove obstacles/adjust

the motion

2156 X-axis stepper motor overtemperature
• Stepper motor sluggish
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace stepper motor
• Replace control

2201 Y-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Cable to reference switch defective
• Reference switch defective

• Align reference switch
• Replace cable
• Replace the reference switch

2202 Y-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace encoder

2252 Y-axis stepper motor excess current • Replace stepper motor
• Replace control

2253 Y-axis stepper motor overvoltage
• Mains voltage too high • Check mains voltage

2255 Y-axis stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2256 Y-axis stepper motor overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace stepper motor
• Replace control

2301 Stroke position stepper motor 
referencing timeout
• Faulty reference switch setting
• Cable to reference switch defective
• Reference switch defective 

• Align reference switch
• Replace cable
• Replace the reference switch

2302 Stroke position stepper motor current 
error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace encoder

2352 Stroke position stepper motor excess 
current

• Replace stepper motor
• Replace control

2353 Stroke position stepper motor 
overvoltage
• Mains voltage too high • Check mains voltage

Error 
code Description Troubleshooting
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2355 Stroke position stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2356 Stroke position stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate sluggishness
• Replace stepper motor
• Replace control

Machine control

3100 Machine control voltage 
• Temporary mains voltage 

interruption 
• Check mains voltage

3102 Machine voltage in sewing motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check mains voltage

3103 Machine voltage in stepper motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check mains voltage

3107 Machine temperature 
• Ventilation openings closed
• Ventilation grille dirty

• Clean ventilation grille
• Check ventilation openings

3109 Threading mode is switched on Switch off threading mode

3121 Compressed air is missing, not 
sufficient

Turn up air pressure and stabilize

3123 Oil sensor active Top off the oil

3210 Thread broken Re-thread the thread

3215 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3220 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3500 Error in calculating the contour data • Reload the contour data
• Check the contour data

3501 Target position of the XY clamps 
outside the motion limits 

Adjust the contour data

3502 Target position of the XY clamps within 
the "forbidden areas"

Adjust the contour data

3721
3722 

Internal error • Switch off and on the machine
• Software update
• Notify DA Service

4201 Internal CF card defective • Switch off and on the machine
• Retrofit/replace control

5301 Program cannot be sewn Copy program to DAC

Error 
code Description Troubleshooting
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6551

6554
6651

6653
6751

6761

Error in machine head position/AD 
converter/process error

Internal error

• Switch off and on the machine
• Software update

• Notify DA Service

6952 Stepper motor driver error
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

Communication

7801 Control panel interface communication
• Cable disturbance
• Cable 

• Switch off and on the machine
• Software update
• Notify DA Service

8151
8156

8159

IDMA error
• Disturbance
• Control defective

• Switch off and on the machine
• Replace control

 8152

8154

IDMA error
• Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

8252
8257
8258

8256
8254

ADSP Boot/Xilinx Boot/ Boot error
Disturbance

• Switch off and on the machine

8351 Test pins error • Switch off and on the machine
• Software update
• Notify DA Service

8400 Control panel has no valid program for 
the DAC.

Load the current program into the 
control panel from a USB key.

8401
8402

Control panel has no valid program for 
the DAC.

Load the current program into the 
control panel from a USB key.

8403 Program in DAC is no longer current. Load the current program into the 
DAC.

8404

8407

DAC update was faulty. • Attempt the update again
• Check cable connection
• Replace the DAC

8408 Waiting for a DAC reset. Wait until the restart has been 
performed 
(Duration: several seconds).

8411 DAC program check is active. Wait until the test has been performed 
(Duration: several seconds).

8414 DAC update succeeded.

Error 
code Description Troubleshooting
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8801

8805
8806
8890
8891

Error in test pins/signal processing/
event processing/
Memory wrapper/
list functions
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

System

9000 Reference run active

9002 Machine head not locked down Lock down machine head

9006 Quick-stop switch is activated. Releasing the quick-stop switch

9016 Wrong bar code ID Change the program

9100 The counter has not reached the 
default value.

Press the OK button. The counter is 
reset.

9601 Stop while sewing on the contour
Continue sewing?

• OK button = 
Continuing the sewing process

• ESC button = 
Canceling the sewing process

9700 Bobbin case retainer for bobbin 
change not closed

Close the bobbin case retainer for 
bobbin change

9701 Parallel clamps not lowered • Remove obstacles
• Align sensors

9900 Incorrect machine parameters Initialize the data

9901 Incorrect sequences Initialize the data

9902 Incorrect program parameters Initialize the data

Error 
code Description Troubleshooting
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22.3 Errors in sewing process

Error Possible causes Remedial action

Unthreading at seam 
beginning

Needle thread tension is 
too firm

Check needle thread tension

Thread breaking Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is bent or sharp-
edged

Replace needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into 
the needle bar

The thread used is 
unsuitable

Use recommended thread

Thread tensions are too 
tight for the thread used

Check thread tensions

Thread-guiding parts, such 
as thread tube, thread 
guide or thread take-up 
disk, are sharp-edged

Check threading path

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists

Skip stitches Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is blunt or bent Replace the needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into 
the needle bar

The needle thickness used 
is unsuitable

Use recommended needle 
thickness

The reel stand is 
assembled incorrectly

Check the assembly of the reel 
stand

Thread tensions are too 
tight

Check thread tensions

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists
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Loose stitches Thread tensions are not 
adjusted to the sewing 
material, the sewing 
material thickness or the 
thread used

Check thread tensions

Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle breakage Needle thickness is 
unsuitable for the sewing 
material or the thread

Use recommended needle 
thickness

Error Possible causes Remedial action
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23 Technical data

23.1 Data and characteristic values

Technical data Unit

91
1-

21
1-

20
10

-1
0

91
1-

21
1-

30
20

-1
0

91
1-

21
1-

10
06

-1
0

Type of stitches 301

Hook type Vertical hook

Number of needles 1

Needle system 794

Needle strength [Nm] 140 - 230

Thread strength [Nm] min. 20/3
max. 8/3

Stitch length [mm] programmable: 1 - 12.7

Speed maximum [min-1] 1400 intermittent

Needle bar stroke [mm] 48

Clamp stroke [mm] 30
with material thickness monitoring: 24

Foot lifter [mm] 20

Sewing foot stroke [mm] 4
can also be switched on and off pneumatically during 

the seam

Sewing field size [mm] 200 x 100 300 x 200 100 x 60

Number of free seam contours 99

Mains voltage [V] 230

Mains frequency [Hz] 50/60

Operating pressure [bar] 6

Length [mm] 940 1200

Width [mm] 1100 1200

Weight [kg] 230
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23.2 Requirements for fault-free operation
Compressed air quality must conform to ISO 8573-1: 2010 [7:4:4].
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24 Appendix

24.1 Wiring diagram
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Appendix
24.2 Pneumatic diagram
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Appendix
24.3 Pneumatic diagram with thread burner
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